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READS General Training Information 
 

1. Parking, restrooms, food/drink, breaks, etc. 

2. Attendance – Attendees Initial the Training Roster each Day 

3. DOT Network Logon for READS Training (for logging on to the computer) 

If you are WisDOT staff, you should be able to logon as yourself. 

If you are a consultant and either do not have a DOT network logon or your logon is 

expired or disabled, the instructor will provide you with a temporary DOT network logon / 

password. 

4. Training WAMS Logon for READS Training (for logging on the READS Training System) 

5. Add a Printer ‐ See Instructor / handout for adding a printer at your training location 

6. Assigned Training Project Numbers:  _______________________ 

7. The DOT Computer Helpdesk 

Staffed Monday ‐ Friday from 6 AM to 5:30 PM every day State offices are open.  Regardless of 

where you work in the state, anyone with a computer related problem or question can contact us.  

During these hours we can be reached directly at both (608) 266‐9434 and (800) 362‐3050. 

We can also be contacted via email but responses to your emails may take up to an hour.  Our 
email address is: DOTComputerHelpDesk@dot.state.wi.us 

8. Training Evaluation 
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To subscribe to the READS email distribution list 

1. Browse to the “Roadway Standards Subscribe” page on WisDOT’s consultant extranet site 

(http://roadwaystandards.dot.wi.gov/standards/subscribe) 

 

2. Click the Real Estate Automated Data System box, enter your email address and click Subscribe 

You will see “Subscription requested. Please check your email for a confirmation message. You must respond 

to this confirmation message to join this list.” 

3.  Click OK 

4.  Go to your email inbox and click the “click here to confirm…” link 
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READS Access requires a WAMS ID and WisDOT Authorization 

To Register For or Manage a WAMS ID, start at the WisDOT WAMS Home Page 
http://goo.gl/v7Ls4 
(https://trust.dot.state.wi.us/extntgtwy/consultants/) 

At the WisDOT WAMS Home Page you can perform the 4 functions shown below. A Wisconsin User ID is 
just another name for a WAMS ID. They are the same thing. 

    

WAMS IDs  

 WAMS (Web Access Management System) IDs are managed by the Wisconsin Department of Administration 

not by the Department of Transportation.   

 WAMS IDs are to be associated with individuals only.  Do not share your WAMS ID.   

 Never disclose your WAMS password to anyone. 

Changing your WAMS ID 

Changing your WAMS ID is not recommended. If you must change your WAMS ID, you must notify the 

READS system administrator (drew.kottke@dot.wi.gov) 

Updating ID profile information 

To view or change your e‐mail address and other information on your extranet profile go to 
https://trust.dot.state.wi.us/extntgtwy/consultants/, then select "Edit your Profile" without entering your 
ID and password. After the page refreshes (you won't see any change in the page), then enter your ID and 
password and select "Login." 

Only you (the WAMS ID account holder) can change your email address in the WAMS System.  
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Wisconsin Access Management System (WAMS) Frequently Asked Questions 
   
Q  How do I gain access to READS? 
A  You setup a WAMS ID and then request access to READS via a WisDOT Region Office 

Supervisor. Specific instructions appear on page 7. 

Q  What is a WAMS ID? 
A  WAMS is an acronym for Wisconsin Access Management System. It is used by all Wisconsin 

State agencies to provide access to web resources. It is managed by the Wisconsin Dept. of 
Administration. WAMS and READS are entirely separate systems. 

   
Q  Is it OK to share my WAMS logon or password? 
A  No. WAMS IDS are associated with individuals. They may not be shared. Never share your 

WAMS password with anyone.   

   
Q  I forgot my WAMS password, what should I do? 
A  Use WAMS Account Recovery at https://on.wisconsin.gov/WAMS/home.  WisDOT staff cannot 

reset your WAMS password.  

   
Q  My WAMS ID is disabled due to "intruder detection" what should I do? 
A  Follow the same process as if you forgot your password. Use Account Recovery at 

https://on.wisconsin.gov/WAMS/home 

   
Q  Do I have to change my WAMS password periodically? 
A  No. Your WAMS ID and password do not need to be changed periodically. 
   
Q  Is it OK to change my WAMS ID? 
A  Changing your WAMS ID is not recommended. If it is necessary, you must notify the READS 

System Administrator (drew.kottke@dot.wi.gov). You will not be able to access READS until 
your READS account is updated to match your WAMS account.  

   
Q  My email address has changed, what should I do? 
A  Update your email address using WAMS Profile Management at 

https://on.wisconsin.gov/WAMS/home.  WisDOT staff cannot change the email associated 
with your WAMS ID. Please also notify the READS System Administrator 
(drew.kottke@dot.wi.gov) so your email address can be updated in READS. 
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Requesting READS (Real Estate Automated Data System) Access 

The WisDOT Real Estate Automated Data System (READS) is available only to WisDOT staff and to 
consultants  
currently under contract with WisDOT. To be granted access, you must provide your WAMS ID and the 
email address of the WisDOT Supervisor approving your request. You should never provide your 
password to anyone. 

From the READS Launch Page, click request approval 

 

 

Once you have a WAMS ID and the approving WisDOT supervisor’s email address, click Next. You will see 
the Request WisDOT READS Access page. Fields with an asterisk (*) are required. 

1.  Enter your first and last name* 

 2.  Specify your employer* (either WisDOT Staff or Consultant) 

 3.  If you are not WisDOT staff, enter information about your company (company name, address, 
city/state/zip) 

4.  Enter your WAMS ID* 

5. Enter the best phone number for you during business hours* 

6. Enter your email address* (suggest using your WisDOT email or business email address as appropriate). 

7. Enter the email address of the WisDOT supervisor approving this request* 

8. Specify all of the roles you are approved (or under contract) to provide. Select at least 1. (acquisition 
specialist, appraiser, contract specialist, program associate, property management specialist, relocation 
specialist, review appraiser, Other, please specify) 

9.  Enter any additional information  

10. Click Done.  

You will see the message: Survey Completed. Your request for READS access has been submitted. You will 
be notified of the status of your request within 2 business days. 

11. Click Close 
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READS Launch Page  

Once you have a WAMS ID, the READS Launch page is accessible via:  

http://goo.gl/44wnR    (https://trust.dot.state.wi.us/extntgtwy/dtid_real_estate/repm/reads) 

Bookmark, or create a desktop shortcut, to the READS Launch Page and not to the READS application.   

Access the READS Launch page by browsing to the WisDOT Consultant Extranet (below left) 

(WisDOT Internet page, click Doing Business, click Consultant Extranet) 

      

READS Launch Page 

  

Zoom 

If you have a wheel mouse, you can use the wheel to alter the size of the text on most Web sites and 
in MS office Applications. Hold down the [CTRL] key as you spin the wheel up and down. 
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Do once from each PC where you access READS 
 

Go to the READS Launch Page 
https://trust.dot.state.wi.us/extntgtwy/dtid_real_estate/repm/reads/ 

 

Click Create desktop shortcut and add READS to the list of trusted sites 
 

   Create a desktop shortcut to READS 

1. Click Download the 'dot‐reads.exe' file  
2. When the 'File Download' windows opens, click 

'Save' 

  
 

3. When the 'Save As' window opens, click 
'Desktop', then 'Save' 
 

 
4. Click Close 

 

     Trust READS on this PC 

1. Download the 'trust‐reads.vbs' file  
2. When the 'File Download' windows opens, click 

'Open' 

 

3. When the 'Security Warning' windows opens, 
click 'Run' 

 

4. When you see the window below, click 'OK' 
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To use READS with Internet Explorer 10 
 

1. In Internet Explorer 10, if the Tools menu is not visible, right‐click near the top and check Menu Bar 
 

 
 

 
2. Click Tools > Compatibility View Settings 
3. Add state.wi.us to Websites you’ve added to Compatibility View 

 

   
 
4. Open READS 
5. Press the F12 key 
6. Click Browser Mode IE10 Compatibility View 
7. Select Internet Explorer 9 and Wait for READS to refresh 
8. Close the F12 window  

  

 
   



Anti‐Virus Scanning 
 
Some anti‐virus software will flag the READS desktop shortcut as potentially unsafe. The file contains 
a small program that opens the READS Launch Page. The file is safe. Set your anti‐virus software 
to allow the file.  
 
Below are the steps WisDOT staff can take to set the file as safe.   
 

After double‐clicking the READS Launch Page shortcut   the message below appears. 
 

1. Click Allow the file 
 

   
 

2. A confirmation window is present. Click OK. 
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Turn off Mixed Content popup for Extranet pages 

Follow the procedure below to prevent this security popup from appearing when entering Extranet 
pages 

  

 1. In Internet Explorer, click Tools > Internet Options  

   

2. Click on Trusted Sites 

3. Click Custom level… 

   

The Security Settings – Trusted Sites Zone window opens 
13



4. Scroll down to Display mixed content and select Enable  

   

5. Click OK and click OK again 

 
  
Turn Pop-up Blocker Off 

The first time you use READS, you may see “Pop-up blocked…” 

Right click the yellow bar and select Always Allow Pop-ups from This Site. 

 

Click Yes 
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READS Highlights 

 Extranet / Oracle application 

 Assignments module 

 Contract management module 

 Cost estimation module 

 Integrated Relocation, Property Management and LPA modules 

 Appraisal features 

o Surplus land appraisals 

o LPA appraisals 

o Comparable db 

 Existing READS data migrated 

 Importing project information from FIIPS.  

 Viewing the Plat from the Project screen (if final and recorded and archived properly by 

region staff) 

 Relocation Comps stored in the system and reusable 

 My Parcels allows users to access parcels specific to the user 

 Adhoc Reporting capability. Allows users to create reports 

 Tickler functionality. Admin users can create ticklers (notifications on events 

completed/due)) for dates in READS 

 Log features including scanning bar‐coded documents 

 Interface to Holidays. If a calculated date falls on a holiday the system will show the next 

day 

 Electronic Signature gets inserted automatically onto some of the documents 

(configurable) 

 Rentals – Allows users to keep track of the payments due and schedule payments 

depending on the lease period 

 Rentals – Leasebacks – the system automatically considers the 30 day free rent period and 

comes up with a payment schedule 

 Allows creation of Short Format Appraisal Report in the system. Keeps track of Surplus 

Land Appraisal and Review process 

 Allows access to the Legal Descriptions stored on the WisDOT LAN from the 

Offer/Negotiations screen 

 Prorated Tax Calculations utility for Partial and Total Acquisition 

 Electronic Authorization of documents 

 

MS Word and Adobe Reader are recommended for use with READS
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System Controls and Conventions 

 Click the Edit button   to modify information on a screen. If you do not see an Edit button you have 

read‐only access to the data fields on the screen 

 

 Once you have entered the desired information into a screen, click the Save button   to save the 
information. The information will be lost if you don’t save the changes 

 

 Clicking the Cancel button   will cancel the current action 

 

 The back button   is found in several places in READS and is used to return to the previous Screen 
 

 The Edit button   is found on tables in READS. Click this button to edit the information for that row of the 
table. 
 

 The Delete button   is found on tables in READS. Click this button to delete the information for that row of 
the table 
 

 The calendar button   will appear next to all date fields. Click to open a calendar, from which you can 
select a date. 

 

 Date:  In the date fields, you can double click on the field to fill in today’s date.  When manually entering a 
date, it is a required to enter four digits for the year. Dates may be entered in either of the following 
formats: mmddyyyy or m/d/yyyy.  For example: 05052010 or 5/5/2010 will store May 11, 2010 in the 
system. 
 

 Click the tab button on your keyboard to move focus from one field to another field on the screen 

 

 Tooltips. Generally available for read‐only fields. Hover over a field to view tooltip information about that 

field. 

 
 Fields with a grey background are read‐only. The value has been entered somewhere else in the database or 

is a calculated field.   

 
 

 Fields with a yellow background are required. The system will alert the user if left blank. 

 
 

 History. Click the Alt button on the keyboard and double click on the screen to view the user history record. 

 

 In Parcel Central the Project ID and Project Name fields are links, click to go to the Project Details.   

 

From Project Details, click   to return to Parcel Central 
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READS Main Menu Overview 

 

Menu  Description 

Project  Project Details – A list of projects entered into READS.  Click a project in the list, a new 
screen opens showing basic project information along with more detailed information 
about assignments and parcels. 

Project  Cost Estimation – It is a list of projects identified by a real estate project ID and a 
design id. By clicking on each row will show the detailed cost estimation 

Parcel  Parcel Central allows the user to enter all information for each property parcel step‐by‐
step through the entire property acquisition process 

Reports  Several different reports can be generated to show the status of the acquisition 
process, the cost, etc.  Custom reports can also be generated.  

My Parcels  My Parcels provides a list of all the parcels that the user who is logged‐in is a part of 
the acquisition team.  The list provides some basic information for each parcel, such as 
status, priority, and the user’s assigned role.  Clicking on the parcel will open the 
General Parcel Information screen in Parcel Central 

My Ticklers  My Ticklers is a notification system that provides targeted messages to users.  The 
Tickler also allows for users to notify other users of tasks which need to be, or have 
been, completed.  The Tickler can also be used to monitor schedules and project 
progress. 

Property Mgmt  Leases ‐ All leases are tracked within this module.  Details about the leases and rent 
information are managed here 

Property Mgmt  Land Inventory ‐ All Surplus Lands and other Land Inventory are tracked within this 
module.  Details about the original purchase and disposition of the surplus land are 
managed here.  

Setup  Setup allows for general maintenance and organization of READS.  Project structure, 
user and security group preferences, and tickler protocol are all managed in this area.  
Staff and Vendor Maintenance, as well as Contract Management are managed in this 
area. 

E‐Submit  Allows Appraisers to esubmit appraisals, project data books and other documents 
directly to the appropriate READS Log 

Acq Comps  Acq Comps is where all Comparable Sales used for appraisals can be entered.  Once a 
comparable is entered it can be associated with the desired project to be incorporated 
in the Appraisal Report. 

E‐Help  E‐Help provides a portal to contact BEM, WisDOT Project Team including the System 
Administrator with questions or concerns that arise regarding READS. 

E‐Manual  Searchable Reference Manual
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Basic Navigation 

When READS opens, the main menu appears. 

 

Navigating to a Project 

Click Project Details 

 

The Project List appears.  

 

Notice that there are 24 pages in the Project List shown above. 

Use the filters at the top of the page to locate the project you are interested in.  One way that works well is 

to set the ROW Acquired For to blank (Statewide search).  Enter the Real Estate Project ID with dashes in 

the Project ID field and click Refresh. 
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The list of projects will be narrowed to display only the project that you entered.  Click the Edit/View icon 

to go to the project screen. 

 

The Project screen appears and the parcel tab opens by default. Here you will see the parcels on the 

project.  To go to an individual parcel, click the Open Parcel icon next to the parcel you are interested in. 

 

The parcel screen and the parcel menu items appear.  To return to the project screen from the parcel 

screen, click the underlined word “Project ID” 
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Navigating to a Parcel Directly 

Click Parcel and then click Search Parcel 

 

You will find the ability to search for parcels by many different methods.  You must know which Region 

Office the parcel is associated with. 
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Assignments 

The assignments shown below can be made for each parcel.  They can be assigned en masse from the 

project screen or individually from the parcel screen.  Assignments enable the My Ticklers and My Parcels 

feature in READS. 

My Ticklers are configurable notifications that are sent based on system events.  For example, the review 

appraiser and contract specialist can be automatically notified when an electronic appraisal arrives. 

My Parcels provides a single place to view just the parcels that the user has an assignment on. 

 

IMPORTANT: The appraiser must be assigned on a parcel before they can esubmit an appraisal for that parcel. 
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Many Assignments may be made at one time from the Project Screen > Assignments tab 

 

Assignments may be made one at a time from Parcel Screen > Acquisition Team  

 

 

NOTE: Use “Review Appraiser, Region” for Region Staff. Use “Review Appraiser, Statewide” for BTS Staff  
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Ex1‐1 

Exercise 1 – Project and Plat (20 minutes) 

Use the project ID and parcel numbers provided by the instructor 

Enter Project Data Manually 

1. Enter Training READS using your Training Logon and Password 

2. Click on Project to go the Project Details screen and click Add New Project 
 

 
 

3. Enter your assigned project number. 
 

4. Project Name: enter a fictitious project name 
 

5. FIIPS Subprogram: enter 303 – State Highway Rehabilitation 
 

6. Project Termini: enter fictitious termini 
 

7. Project Highway: enter a project highway 
 

8. FIIPS Concept: enter RECST 
 

9. ROW Acquired For and By: Green Bay 
 

10. Enter Sales Study Date, Relo Plan Approval Date and Design ID (0000-__-01) 
 

11. Click Save 
 

  
 

12. Notice the yellow required fields and the gray read-only fields. 
 

13. Mouse over several fields and get used to using the pop-up tooltips. 
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Ex1‐2 

Add Project Counties 
 

1. Next to Project Counties table, click Add New 
 

2. Add Counties Brown and Outagamie 
 
 

 
 
Add Construction IDs 
 
1. Next to Construction IDs table, click Add New 

 
2. Add Construction IDs ____-__-75 and ____-__-77, where __ is the same as in your training project id. 
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Ex1‐3 

Plat and Parcels 
 
You are now ready to enter parcels 
 

1. Click the Plat Summary tab 
 

 
 

2. Click Add Plat Sheet 
 

3. Enter Plat sheet 4.01 and parcels 2, 4, 6, 8 and 10 
 

 
 

4. Click Save & Create Parcels 
 
 

5. Click the icon in the Amend column for sheet 4.01 
 

 
6. Amend parcel 8 and click Save (Note that the sheet number and amendment number are read-only). 
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Ex1‐4 

Construction IDs 
 

1. Click the Construction IDs tab 
 

2. Click the icon in the Assign column for ____-__-75 
 
 

 
 

3. Assign Construction ID ____-__-75 to parcels 2, 4 and 6. 
 

4. Click Save 
 

 
 

5. Using the same process, assign Construction ID ____-__-77 to parcels 8 and 10. 
 

 
Note: A similar process may be used to assign counties and target acquisition dates to parcels. 
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Ex1‐5 

Assignments 
 

1. Click the Assignments tab. 
2. Click Create New 
3. Select the Acquisition Specialist Role 
4. Assign Cindy White to All Parcels 
5. Click Save 

 
 

 
6. Click Create New 
7. Select the Appraiser Role 
8. Assign Larry Stein to All Parcels 
9. Click Save 

 
 
10. Click Create New 
11. Select the Review Appraiser, Region Role 
12. Assign Marvin Braund to Selection of parcel (2, 6 and 8) 
13. Click Save 
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Ex2‐1 

Exercise 2 – Parcels, Participants and Interests (35 minutes) 

Use the project ID and parcel numbers provided by the instructor 

1. Enter Training READS using your Training Logon and Password 

An easy way to get to a particular parcel in the system is to enter part of the Project ID on the Project Details 
screen and click Refresh. READS will display the projects with a matching partial Project ID. Try it. 

2. Enter the first 4 numbers of your training project ID on the Project Details screen and click Refresh.  

3. Click the icon in the Edit column for your training project. 

 

READS will display the project information and open the parcels tab by default 

 

4. Click the icon in the Open Parcel column for the first parcel on your project. 

READS will display the parcel information for the parcel 
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Ex2‐2 

Enter Data for Nominal Parcel Number 2 

 

5. Click Edit 
 

6. Enter:  
a. Parcel Type: Nominal 
b. Current Status: Waiver 
c. Property Address: 1265 Lombardi Ave 
d. City: Green Bay, State: WI,  Zip: 54304 
e. Set Homestead to Yes 
f. Enter Zoning and Present Use 
g. Enter a Taxing Unit and a Tax Key number 
h. Enter a Brochure Sent date. 
i. Enter Title Information 

 
7. Click Save 

 
8. Click the Google Maps Link 

 

9. Click Next Parcel  
 
 

a 
b 

c 

d 

e

f

g

h

i
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Ex2‐3 

Enter Data for Appraisal Parcel Number 4 
 

 
 

10. Click Edit 
 

11. Enter:  
a. Parcel Type: Complex 
b. Current Status: Appraisal 
c. Property Address: 944 Vanderperren Way 
d. City: Green Bay, State: WI,  Zip: 54304 
e. Set Homestead to Yes 
f. Enter Zoning and Present Use 
g. Enter a Taxing Unit and a Tax Key number 
h. Enter a Brochure Sent date. 
i. Enter Title Information 

 
12. Click Save 

 
Enter an additional Tax Key Number for parcel 4 
 
13. Click Add New by the Taxing Unit table and enter a second Tax Key number 

 

 

a 
b 

c 

d 

e

f

g

h

i
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Ex2‐4 

14. Click Previous Parcel to Return to parcel 2 
 

15. Click the Acquisition Team button under the Parcel Central Menu 
 

 
 

16. Click the Contract Specialist Role and make an assignment 
 

17. Click the Region Supervisor Role and make an assignment 
 

18. If your information appears in the READS system, assign yourself as an Acquisition Specialist on parcel 2.  
This will allow you to access the parcel using My Parcels on the Main Menu. 
 

19. Click the Next Parcel button  and make appropriate assignments for parcel 4. 
 

20. Click the Participants button under the Parcel Central Menu  
 

 

31



 

Ex2‐5 

Add Owner Participant for Nominal Parcel 2 
 
1. Click Add New 

 

 
 

2. Select Individual 
 

3. Enter First and Last Name 
 

4. Leave Relocation set to No 
 

5. Set Participant Type to Owner 
 

6. Click Copy Property Address checkbox to use the Property Address as the Mailing Address 
 

7. Enter phone numbers and email address 
 

8. Click Save 
 

9. Click the Back button  
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Ex2‐6 

Add Mortgagee Participant for Nominal Parcel 2 
 
1. Click Add New 

 

 
 

2. Select Legal Entity 
 

3. Click the Corporation checkbox 
 

4. Enter a Business Name 
 

5. Set Participant Type to Mortgagee 
 

6. Enter Contact Information 
 

7. Click Save 
 

8. On the Mortgage Table, click Add New 
 

9. Enter Mortgage data and click Save 
 

 
10. Click the Back button and then click the Next Parcel button  
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Ex2‐7 

Add Owner Participant for Appraisal Parcel 4 
 
1. Click Add New 

 

 
 

2. Select Individual 
 

3. Enter First and Last Name 
 

4. Set Relocation to Yes and enter Unit Number 100A 
 

5. Set Participant Type to Owner 
 

6. Click Copy Property Address checkbox to use the Property Address as the Mailing Address 
 

7. Enter phone numbers and email address 
 

8. Click Save 
 

9. Click the Back button  
 

 
Add Tenant Participant for Appraisal Parcel 4 
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Ex2‐8 

 
1. Click Add New 

 

 
 

2. Select Individual 
 

3. Enter First and Last Name 
 

4. Set Relocation to Yes and enter Unit Number 101A 
 

5. Set Participant Type to Tenant 
 

6. Click Copy Property Address checkbox to use the Property Address as the Mailing Address 
 

7. Enter phone numbers and email address 
 

8. Click Save 
 

9. Click the Back button 
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Ex2‐9 

Add Mortgagee Participant for Appraisal Parcel 4 
 
1. Click Copy Existing 

 

 
 

2. In the Participant name field, enter “first national” and click Find 
 
READS will search for participants in the system matching that name. 

 
3. Set Participant Type to Mortgagee and click the icon in the Copy column 

 

 
 
 

4. READS will ask if you are sure you want to copy the participant, click OK 
 
We are done entering participants for parcels 2 and 4. 

 
5. Click the Previous Parcel button to return to parcel 2. 

 
6. Click the Interests button under the Parcel Central Menu 
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Ex2‐10 

Add Interests Required for Parcels 2 and 4 
 
1. Verify that you are on parcel 2 and click the Edit button 
 

 
 

2. Set Access Rights to No 
 

3. Enter a Total Size of 0.75 (acres) 
 

4. Under Type of Interest, select Fee 
 

5. In the Size field, enter 0.1 and leave Unit set to acres 
 

6. Click the Next parcel button  
 

7. Verify that you are on parcel 4 and click the Edit button 
 

 
 

8. Set Access Rights to Yes 
 

9. Enter a Total Size of 1.20 (acres) 
 

10. Under Type of Interest, select Fee  
 

11. In the Size field, enter 0.55 and leave Unit set to acres 
 

12. Click Add New Interest 
 

13. Also enter a Permanent Limited Easement (PLE) of 0.25 acres 
 

14. Click Save 
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The Negotiation Diary  

The purpose of the Negotiation Diary (WisDOT Form DT2058) is to present a clear picture of what 

transpired during the negotiation of the particular parcel or land being acquired.  

WisDOT Real Estate staff and consultants are required to use the READS system to generate 

diaries. 

Use at least the first initial and full last name of the person making the entry.  In the case of the 

parcel's main Real Estate agent, the full name only needs to be entered once. Initials will suffice 

for the remaining entries. Timely, accurate and detailed entries are critical.  One technique that 

can work for remembering details is to immediately record key points of the negotiation on a 

portable recording device for later review; this can prove to be useful when updating diaries. The 

following shall be documented: 

1)  All discussions and meetings with property owners. 

2)  All discussions and meetings with any parties of interest. 

3) All discussions and meetings with management and other staff including what was decided 

or not decided. 

 In the event of disputes, litigation, audits, or other future situations, such documentation 

will serve as a reference and clearly tell the story. Note who attended and what was 

discussed.  

 An email trail does not replace diary notes.  

o An email trail can be included in the file, but a summary of what occurred is what is 

needed in the READS diary notes. 

 Have been other negotiations with the same property owner and whether or not there was 

an agreement. This may be helpful when defending the Department in litigation.  

 If more money is expected, it should be noted how much more the property owner thinks 

they are entitled to and what they are basing that amount on.  

o This is helpful to the Department during mediation. 

 Note whatever issues the property owner has concerns about. 
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The provisions regarding what items must be maintained in the region’s official files are found in the 
Wisconsin relocation rules in Wis. Admin. ch, Adm 92. (Wi Stats 32 and 84 are silent with regard to a 
negotiation diary requirement). The following language is found in Adm 92.20. 

 

Adm 92.20(1) (1) Property acquisition file. An individual property acquisition file shall contain:  

 (a) The name and address of a property owner and the address or other legal description of an acquired 
property;  

 (b) Evidence that the property owner was given a pamphlet entitled, "Your Rights as a Landowner 
under Wisconsin Eminent Domain Law," and the date given;  

 (c) A copy of written notices under this chapter or otherwise given to a displaced person;  

 (d) A copy of appraisal reports or documents on which a determination of just compensation is based;  

 (e) A copy of the written offer to purchase and the date of initiation of negotiations to acquire a 
property;  

 (f) A copy of a purchase agreement, deed, declaration of taking, waiver or related document involving 
conveyance of the property;  

 (h) Evidence that a property owner was paid for the purchase price and expenses incurred incidental to 
transfer of the property as specified under s. 32.195, Stats.  
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Legal Descriptions and READS 
 

READS can import the legal description from Microsoft Word and place it directly on the face of a 

conveyance. Alternatively, the legal description can be attached to the conveyance as a separate page. In 

that case, the language: “Legal description is attached and made a part of this document by reference.” 

must appear on the face of the conveyance. 

 

For a legal description to be displayed on the face of a conveyance generated by READS 

 

The legal descriptions must be saved as Legals must be saved as Word .docx files in the Region Office 

N:\Apps\READS\Legals folder, in a folder named with the 8 digit Real Estate Project ID as shown below. No 

other characters are allowed in the folder name.  

 

 
 
Each legal description MS Word document is named: 10000020.003.docx 

 
Where: 

 
10000020  The 8 digit project id must be the first 8 characters. No dashes. 

 
.003  The 3 digit parcel number is immediately after the first period. 
         The parcel numbers are 3 digits (e.g. parcel 1 must be 001). 

 
.docx  The .docx extension (.doc extension is not supported). 

 

NOTES:  

Any text in the header or footer is ignored by READS. Use the header for including the title "legal 

description" and any other information desired. Use the footer for including the project and parcel number 

if desired. 

 

The font used in preparing the legal description is ignored by READS. The legal description is displayed in 

the Arial font on the conveyance.  

 
If a legal description is too long to fit on the page, the language "Legal description is attached ..." will 

appear on the face of the conveyance and the legal description will be attached.   
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Ex3‐1 

Exercise 3 – Nominal Valuation & Offer (20 minutes) 

Use the project ID and parcel numbers provided by the instructor 

1. Enter Training READS using your Training Logon and Password 

2. Navigate to Parcel 2 of your project (Click Project > Project Details, Find your project and click the icon  
in the Edit column next to your project, click the icon in the Open Parcel column next to parcel 2) 

3. Click the Waiver of Appraisal button under the Parcel Central Menu  

 

4. Click the Edit button directly above the Allocation Table 

5. Enter an optional description for the Land in the Description Field 

6. Enter a Per Unit value for the Land 

7. Click Save 

Now you are ready to approve the allocation and create a proposed offer 

8. Click the main Edit button (to the right of the green Waiver of Appraisal label) 

 

9. Place a check in the Create Proposed Offer checkbox 
 

10. Fill in Approved By and Approved On and click Save 
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Ex3‐2 

 
11. READS will prompt you to confirm that you wish to create an Offer record.  Click OK. 

 

 
 

12. Now click on the Offers / Negotiation button under the Parcel Central Menu 
 

 
 

13. Place a check in the checkbox next to the Waiver of Appraisal Offer. 
 
On the Offer/ Negotiation screen you can enter an Initiation of Negations Date and Offer Accepted Date.   
This is also where Conveyance and Recording Date is entered. 
 
14. Click the Diary tab and click Add Diary Item 
 

 
 

15. Make a Diary Entry.  Note that a Subject is required. Click Save when done. 
 

We will spend time on diary items and the READS Log in another training exercise. 
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Ex3‐3 

Create a Warranty Deed Document for Parcel 2 
 
1. From the Offer screen for parcel 2, click the Documents tab 

 

 
 

Notice that you may Show: Letters, Documents or All. You may also filter the list of documents by the Type of 
Document using the pull down menu 

 
2. Select Documents  

 
3. Scroll to the bottom of the list and click the icon in the Generate column next to Warranty Deed 

 
4. Place a checkmark next to the owner’s name indicating that he will sign the deed and click Generate 

Document (below left)  
 

 

READS will generate the document, save a copy in the Log and send the document to MS Word to open.   
 

5. Word will prompt you to Open, Save or Cancel.  Click Open (above right) 
 

6. MS Word will open the Warranty Deed.   
 

7. Inspect the document to verify that it is correct.  Conveyances are protected and must not be edited.   
 
8. Print the document to the local printer (your instructor can advise you on the printer to use).  We will use 

this document later during another exercise. 
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Ex3‐4 

Introduction to the READS Log 

The READS Log can serve as the project file and the official location for documents. There is a project log for 
every project and a parcel log for every parcel.  In the Relocation Log each Unit Number has its own log. 

Each Parcel Log is made up of several smaller logs.  There are Logs for each of these areas within each 
parcel: Waiver of Appraisal, DOT Appraisal, Owner Appraisal, Offer/Negotiations, Relocation, Litigation and 
Buildings & Structures.  Together, they combine to make up the Parcel Log. 

Log entries are made by these actions 

1. Generate a document. Documents are saved in the log where they originated. 

2. Upload an edited document to the Log. It is possible to edit a generated document and upload it to the 
Log replacing the original.   

3. Make a Diary Entry 

4. Enter a Comment. Like a Diary entry although this is information that is not included on the negotiation 
diary document. 

5. Manually attach a document. It is easy to upload other documents from outside the system (for 
example, an PDF appraisal document E-Submitted with the old E-Submit system) 

6. Attach a document via barcode scanning.  This is an automated way of uploading documents to the 
log.  This will be covered in a separate exercise. 

7. Sending an email from the Log.  An email, with or without an attachment, may be sent from the log.  
Emails are never received in the Log, only sent.   

8. E-Submit a document to the Log. When the READS E-Submit tool is used, the submitted documents 
go directly to the appropriate Log. 

We will spend additional time on the READS Log in another exercise. 

1. While still on the Offer screen for parcel 2, click the Log tab 
 

 
 

You will see 2 entries.  You will see the diary entry that you created and you will also see the Warranty Deed 
that you generated.  The most recent log entries appear at the top of the list.   
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Ex3‐5 

2. Click Send Email 
 

3. Compose a test email to yourself from the READS Log.  You will be able to retrieve the message later.  A 
record of the sent email will be saved in the Parcel Log for parcel 2. 
 

 
 

4. Click Send when done.  
 

5. Click OK when READS notifies you that the email was sent 
 
Now the READS Log for Parcel 2 include these 3 items 
 

 
 

Only the individual that made the Log entries, the READS local experts and the System Administrator can 
Edit or Delete Log entries. 
 
Notice that there are several filters available for viewing Log entries.  As the Logs grow longer, using the 
filters will be far more convenient than paging and scrolling through the Log. 
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Correctly Entering Remnants in the READS  
Alternate A – Entire Acquisition  

An Alternate A Offer is used when the owner is left with no property after the acquisition of the remnant 

and fee needed for the project (A total buyout). 

Enter plat information in the interest screen.  This information should only be what is required for the 

project.  It should NOT include any remnant property. 

 

Enter information in the DOT Appraisal screen according to the appraisal.  This information should only be 

what is required for the project. 

 

Once the DOT appraisal is approved, the offering price is listed on the Offer/Negotiations screen. 

Click on the create offer button. 
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Complete the pop up window as shown. 

 

Click the add new icon to add an allocation for the remnant.   
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Complete the pop up window with the remnant information.  Use the remnant’s after value in the DOT 

appraisal as the value for this allocation. 

 

Here is an example of a correctly entered allocation.  

 

 Note the total allocation is the before value from the DOT appraisal.  An alternate offer should 

never be more than the before value. 

 Note the land and severance allocation is not altered. 

Click the back button to return to the Offer/Negotiation screen. 
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Check the “select” box for the Alternate A before generating the Alternate Offer To Purchase form.  Next 

click the Documents tab.  Click the generate button for the Alternate Offer To Purchase. 

 

Click the check box next to Alternate A.  Fill in the Compiled By, Reason for Purchase, and Supported By 

fields.  Click the generate document icon to create the form. 
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Alternate B – Acquisition of Remnant Tract 

An Alternate B Offer is used when the owner is left with property after the acquisition of the remnant and 

fee needed for the project. 

Enter plat information in the interest screen.  This information should only be what is required for the 

project.  It should NOT include any remnant property. 

 

Enter information in the DOT Appraisal screen according to the appraisal.  This information must be only  

what is required for the project. 

 

 

Once the DOT appraisal is approved, the offering price is listed on the Offer/Negotiations screen. 

Click on the create offer button. 
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Complete the pop up window as shown. 

   

Click the add new icon to add an allocation for the remnant.   
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Complete the pop up window with the remnant information.  Use the remnant’s after value in the DOT 

appraisal as the value for this allocation. 

 

Click the add new button again to add another remnant, if needed.   

Here is an example of a correctly entered allocation for 2 remnant tracts.   

 Note an alternate offer should never be more than the before value. 

 Note the Land’s size and value allocation were not altered. 

 

Click the back button to return to the Offer/Negotiation screen. 
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Check the “select” box for the Alternate B before generating the Alternate Offer To Purchase form.  Next 

click the Documents tab.  Click the generate button for the Alternate Offer To Purchase. 

 

Click the check box next to Alternate B.  Fill in the Compiled By, Reason for Purchase, and Supported By 

fields.  Click the generate document icon to create the form. 
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Ex4‐1 

Exercise 4 – Appraisal & Offer (10 minutes) 
 
Use the project ID and parcel numbers provided by the instructor 

1. Enter Training READS using your Training Logon and Password 

2. Navigate to Parcel 4 of your project in Parcel Central (Click Project > Project Details, Find your project and 
click the icon in the Edit column next to your project, click the icon in the Open Parcel column next to parcel 
4) 

3. Click the DOT Appraisals button under the Parcel Central Menu  

4. Click the icon in the Edit column next to the appraisal 

 
 

The Appraisal screen will open with the Allocation tab selected 
 

 

5. Click the Edit button directly above the Allocation Table 

6. Enter optional descriptions for the Land and PLE in the Description fields. Enter Per Unit Values for Each 
 

 
 

7. Click Save 
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Ex4‐2 

Objective Review and Appraisal Review 
 
1. Click the Objective Review Tab 
 

  
 
2. Click the Edit button above the Objective Review checklist table 
 
3. Click Yes in the checkbox for the appropriate items in the Objective Review checklist. Note that you may 

have to scroll to view all the items. 
 
4. Click Save 
 
5. Click the Diary Tab 

 
6. Click Add Diary Item 

 
7. Make one or more Appraisal Diary Entries and Click Save 
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Ex4‐3 

8. Click the Checklist Tab 
 

 
 

9. Click the Edit button above the Reviewer checklist table 
 
10. Click Yes in the checkbox for the appropriate items in the Reviewer checklist.  Note that you may have to 

scroll to view all the items. 
 
11. Click Save 

 
12. Click the Documents Tab 

 
13. Click the icon in the Generate column next to Appraisal Review (DT2128) 

 

 
 
READS will generate the document, save a copy in the Log and send the document to MS Word to open.   

 
14. Word will prompt you to Open, Save or Cancel.  Click Open 

 
MS Word will open the Appraisal Review Document 

15. Inspect the document to verify that it is correct.  Fill in additional information if 
needed. 
 
 

16. When you modify a READS document, you must save it to your computer and 
upload it to the Log.  After making all necessary changes to the document, click the 
round Office button and then click Save As 

An easy way to keep track of the document temporarily is to save it on your desktop 
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Ex4‐4 

17. In the Save As dialog box, click Desktop on the left side and make note of the file name (in this case, 
Doc17266[1].rtf) and click Save 
 

 
 
18. Now click the Log tab and you will notice a paper clip icon in the Upload column next to the Appraisal 

Review document. 
 

 
 

19. Click the paper clip icon and the Document Info screen appears 
 

 
 
20. Click the Browse button and the Choose file dialog appears 
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Ex4‐5 

21. Click Desktop again on the left side and double-click the modified Appraisal Review document 
 

 
 

READS will upload the modified version of the Appraisal Review document and overwrite the original  
 

 
Appraisal Approval 
 
1. Click the Review Details Tab 
 

 
 

2. Enter an Object Review Completed date. 
 

3. Change the Review Status to “Accepted and Recommended” 
 

4. Click Create Proposed Offer 
 

5. Select the appropriate individual under Approved By 
 

6. Enter the Approved On date. 
 

7. Click Save 
 

8. READS will prompt you to confirm that you wish to create an Offer based on the Appraisal.  Click OK. 
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Electronic Records Law 

Wisconsin Statutes 137.15 
Legal recognition of electronic records, electronic signatures, and electronic contracts.  

 (1) A record or signature may not be denied legal effect or enforceability solely because it is in electronic form.  

 (2) A contract may not be denied legal effect or enforceability solely because an electronic record was used in its 

formation.  

 (3) If a law requires a record to be in writing, an electronic record satisfies that requirement in that law.  

 (4) If a law requires a signature, an electronic signature satisfies that requirement in that law.  

  

Wisconsin Statutes 706.25 
Uniform real property electronic recording act.  

(1)  DEFINITIONS. In this section:  

 (c) "Electronic document" means a document that is received by the register of deeds in an electronic form.  

 (d) "Electronic signature" means an electronic sound, symbol, or process attached to or logically associated with a 

document and executed or adopted by a person with the intent to sign the document.  

 (2) VALIDITY OF ELECTRONIC DOCUMENTS.  

(a) If a law requires, as a condition for recording, that a document be an original, be on paper or another tangible 

medium, or be in writing, the requirement is satisfied by an electronic document satisfying this section.  

 (b) If a law requires, as a condition for recording, that a document be signed, the requirement is satisfied by an 

electronic signature.  

 (c) A requirement that a document or a signature associated with a document be notarized, acknowledged, 

verified, witnessed, or made under oath is satisfied if the electronic signature of the person authorized to perform that 

act, and all other information required to be included, is attached to or logically associated with the document or 

signature. A physical or electronic image of a stamp, impression, or seal need not accompany an electronic signature.  
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Electronic Records ‐ Digital Originals vs. Scanned 
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To Save a READS Document or Letter as a PDF using MS Word 2007 
READS documents are created as RTF (Rich Text Format) documents by default.  RTF documents are relatively easy to modify 

using MS Word. To discourage editing of electronic documents, save READS documents to PDF (Adobe Portable Document 

Format) prior to electronic transmission to a party outside the Department (e.g. a property owner). 

1. With the document open in MS Word 2007, click the Office button, then Save As, then PDF or XPS 

 

 
 

2. Specify the Save in folder and the file name (It’s OK to leave the Optimize for and Options Settings as is) 

 

 
 

3. Click Publish 

 

Attach the PDF to the appropriate READS log and email to the desired party. 
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If You Must Scan ‐ Reduce the File Size of the Scanned PDF in Acrobat  
 

1. After scanning, open the PDF in Acrobat. 
 

2. Click File > Save As > Reduced Size PDF 
 

 

3. In the Reduce File Size dialog leave “Make compatible with” set to Acrobat 6.0… and click OK 
 

 

4. In the Save As dialog box, select a folder and give the file a name. Click OK. 
 

   

5. Wait a minute for Acrobat to save a new copy. Acrobat can significantly reduce the file size without reducing 
the quality. 
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READS Logs 

The READS Log serves as the project file and the official location for project and parcel documents. 

Log Types 

Project 

Parcel 

Waiver (No Diary) 

DOT Appraisal 

Owner Appraisal (No Diary) 

Offer / Negotiations 

Relocation (each unit number has a Log) 

Litigation 

Buildings and Structures 

 

Documents get into the READS Logs by these actions 

1. Generate a document from the Log 

2. Upload an edited document to the Log 

3. Make a Diary Entry 

4. Enter a Comment 

5. Manually attach a document 

6. Attach a document via barcode scanning 

7. Send an email from the Log 

8. Esubmit a document to the Log 
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Barcode Scanning to the READS Log  

Many documents that originate in a READS Log, can be scanned and automatically return to that same READS Log via a barcode.  

Deeds and other documents that are signed or filled in outside of the READS system, typically have a barcode on the face of the 

document.  The barcode identifies the document and the Log that it originated from.  Scan documents using the instructions 

below, the document will be routed automatically to the Log where it originated. 

READS barcode scanning works from these devices only 

 

To scan a bar‐coded document to the READS Log 

 

NOTES: 

Only the 1st page of a multi‐page document needs a barcode.  All subsequent pages are included as part of a single document 

until one of the following 2 things happens.  1) the last page of the scanning job is reached.  In this case all scanned pages are 

included in a single document; or 2) another valid READS barcode is encountered. In this case a completely new document is 

started at the second barcode. This repeats until the last page of the job is reached. 

Multiple documents may be scanned at once as long as each document begins with a READS barcode. 

Printing and scanning 1‐sided documents is recommended. 
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Turn Off Word 2007 Document Protection 

1. If the Developer Tab appears on the ribbon, click the Developer tab 

 

2. If the Developer tab does not appear, click the round Office Button in the upper left corner 

3. Click the Word Options button 

 

4. On the Word Options dialog (Popular tab) click Show Developer tab in Ribbon and click OK.  

 

5. Now click the Developer tab 

6. Click Protect Document and then click Restrict Formatting and Editing  

 

7. Now click the Stop Protection button in the lower right.   
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Turn On Word 2007 Document Protection (for filling form fields) 

1. Follow steps 1‐6 on the previous page to open the Restrict Formatting and Editing controls 

2. Check “Allow only this type of editing in the document:” and set the pull down menu to Filling in forms. 

 

3. Click Yes, Start Enforcing Protection 

4. Leave the password fields blank and click OK. 
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READS Documents and Letters
(WisDOT Form Number Shown in Parens if Applicable)

Offer / Negotiations Log ‐ Documents
Acquisition Survey

Administrative Revision (DT1592)

Agreement for Purchase and Sale of Real (DT1895)

Agreement for Purchase and Sale of Real Estate ‐ Long Form (DT1618)

Alternate Offers To Purchase (DT1975)

Award of Damages by County Highway Committee (DT1545)

Award of Damages by State of Wisconsin (DT1584)

Award of Damages by Statute Number (DT1559)

Condominium Notice

Construction Permit Recommendation and Approval (DT1732)

Deed By Corporation (DT1546)

Discharge of Lis Pendens (DT1566)

Disposition of Real Estate Taxes (DT1616) ‐ Pro Rata Taxes tab

Donation ‐ Waiver of Appraisal Recommendation and Approval (DT1896)

File Closing Report

Highway Easement (DT1565)

Jurisdictional Offer (DT1786)

Negotiation Diary (DT2058)

Nominal Payment Parcel ‐ Waiver of Appraisal (DT1897)

Notice of Lis Pendens (DT1547)

Offering Price Report and Submittal (DT1894)

Ownership Information Record

Partial Release of Mortgage  ‐ Mortgage Release tab

Permanent Limited Easement (DT1552)

Personal Representative Deed (DT1564)

Property Improvements/Remnant Report (DT1961)

Property Inventory/Disposition Report (DT1949)

Quit Claim Deed by Corporation (DT1548)

Quit Claim Deed State Grantor (DT1563)

Quit Claim Deed State Purchase (DT1562)

Real Estate Transactions Closing Statement (DT1617)

Relocation Survey

Satisfaction of Mortgage  ‐ Mortgage Release tab

Statement to Construction Engineer (DT1528)

Temporary Limited Easement (DT1577)

Temporary Right of Entry Easement (DT1561)

Trustee's Deed (DT1529)

Warranty Deed (DT1560)
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Offer / Negotiations Log ‐ Letters
Administrative Revision Letter

Assessor Letter

Award of Damages Letter

Closing By Mail Letter

Condominium Association Letter

Conveyance/IRS/Closing Statement Letter

Initiation of Negotiations Letter ‐ Appraisal

Initiation of Negotiations Letter ‐ Waiver

Jurisdictional Offer Letter

Owner Reimbursement (Appraisal Services) Letter

Register Of Deeds (Lis Pendens and J.O.) Letter

Register of Deeds (Recording) Letter

Request Taxpayer ID (IRS W‐9) Letter

Six Month Deed (Check) Letter

Six Month Deed Letter

Temporary Limited Easement Letter

Project Log

Documents

Nominal Payment Parcel Report (DT1889)

Project Cost Allocation (DT1532)

Real Estate Encumbrance (DT1597)

Relocation Order (DT1708)

Letters

Introduction Hardship Letter

Introduction Wetland Letter

Lease QuitClaim Deed Long Letter

Lease QuitClaim Deed Short Letter

Owner Introduction Letter

Representatives Letter

Senators Letter

Appraisal Log ‐ Documents
Appraisal Objective Review

Appraisal Report

Appraisal Review (DT2128)

Misc
Letter Builder

Mailing Labels

Payment Request

Scanning Cover Sheet
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Relocation Log

Documents

Bill of Sale (DT2166)

Business Comparison Chart (DT1958) business only

Business Moving Expenses ‐ Worksheet business only

Business Questionnaire (DT1970) business only

Certificate of Legal Residency Form

Determination of Supplemental Replacement of Business or Farm Payment 

(DT1609)

business only

Farm Comparison Chart (DT1972) business only

Farm Questionnaire (DT1971) business only

Individual Relocation Case Report

Inspection and Certification of Decent, Safe, Sanitary Replacement Housing 

(DT1950)

residential only

Replacement Housing Payment Computation ‐ Owner (DT1943) residential only

Relocation Assistance Diary (DT1957)

Relocation Claim (DT1527) ‐ Claim tab

Relocation Package Receipt

Relocation Payment Estimate ‐ Business & Farm (DT1973) business only

Relocation Payments Summary ‐ Business / Farm / Non‐Profit (DT1679B) business only

Relocation Payments Summary ‐ Residential (DT1679R) residential only

Replacement Housing Payment Computation ‐ Tenant (DT1948) residential only

Residential Comparison Chart (DT1947) residential only

Residential Questionnaire ‐ Inventory of Individual Needs (DT1968) residential only

Residential Survey Questionnaire (DT1969) residential only

Restablishement Expenses ‐ Worksheet business only

Searching Expenses Record (DT1960) business only

Self Move Agreement (DT2266) business only

Vacancy Notice (DT1783)

Letters

30 Day Notice to Vacate Letter

48 Hour Notice Letter

90 Day Occupancy (90 Day Notice of Occupancy) Letter

Disconnection of Utility Services Letter

DSS Replacement Inspection Letter residential only

Financial Commitment ‐ Owner Letter

Initiation of Negotiations ‐ Business Owner Letter business only

Initiation of Negotiations ‐ Business Tenant Letter business only

Initiation of Negotiations ‐ Residential Owner Letter residential only

Initiation of Negotiations ‐ Residential Tenant Letter residential only

Moving Cost Estimate Letter

Notice of Intent To Acquire Letter

Occupancy and Summary Letter

Rent Loss Letter & Agreement Letter
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Ex5‐1 

Exercise 5 – READS Log (10 minutes) 
 
Use the project ID and parcel numbers provided by the instructor 

1. Enter Training READS using your Training Logon and Password 

2. Navigate to Parcel 4 of your project (Click Project > Project Details, Find your project and click the  
icon in the Edit column next to your project, click the icon in the Open Parcel column next to parcel 4) 

3. Click the Relocation button under the Parcel Central menu 

 

4. Click the icon in the edit column next to the first relocatee 
 

5. Click the Documents tab 
 

6. Scroll down to the Residential Questionnaire – Inventory of Individual Needs (DT1968) document and click 
the icon in the Generate column.  
 

 
 

7. READS will generate the document, save a copy in the Log and send the document to MS Word to open.   
 

8. Word will prompt you to Open, Save or Cancel.  Click Open 
 

9. Inspect the document to verify that it is correct.   
 

10. Print the document on your local printer and retrieve the hardcopy. 
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Ex5‐2 

11. Now click the Diary tab and then click the Entry Diary Item button 
 

 
 

12. Make a diary entry and click Save 
 

13. Now click the Parcel Log button under the Parcel Central Menu 
 

14. Notice that the Appraisal Log entries and the Relocation Diary entry appear in the Parcel Log.   
 

15. Use the Category filter to see just the Relocation Log entries. 
 

 
 

16. Set the Category filter back to show all Parcel Log entries by selecting the blank at the top of the list. 
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Ex5‐3 

Attaching Documents to a READS Log  

It is easy to attach documents to a READS log. MS Office documents, images or scanned documents may  
be added to any Log using the Attachment Document button.   
 
Note: Scanning should be the last resort when there is no easy way to get an electronic original copy. 
 

 
 
When the Attach Document button is clicked, the Document Info screen appears.  Select (or enter a new) 
Document Type, enter a Subject, Browse to the document on your file system and click Save. 

 

 

Barcode Scanning to the READS Log  

Many documents that originate in READS, can be scanned and automatically return to the same READS Log  
via a barcode. Deeds and other documents that are signed or filled in outside of the system, typically have a 
barcode on the face of the document. The barcode identifies the document and the Log that it originated from.   

 

READS barcode scanning works from these WisDOT devices only 
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Ex5‐4 

Scan barcoded documents to the READS Logs 

1. Get out the parcel 2 Warranty Deed you printed in exercise 4 and the parcel 4 Residential Questionnaire 
that you generated in this exercise. 
 

2. Write your name on each document so you will recognize them as different from the originals created by 
the READS system. 
 

3. Put one document on top of the other to create a packet for scanning. It does not matter which one is on 
top.   
 

4. Go to the appropriate device at your READS training location (it appears on the previous page) and follow 
the instructions below 

 

 

 

Return to the READS system and find the scanned documents 

1. Browse to the Parcel Log for parcel 2 and look for the Warranty Deed.  Open the document and verify that 
it is the document just scanned. 

2. Browse to the Parcel Log for parcel 4 and look for the Residential Questionnaire. Open the document and 
verify that it is the document just scanned. 

 

NOTES about READS barcode scanning 

A coversheet may be generated for scanning any document that does not have a READS barcode on the first 
page. This functions similarly to a fax coversheet.  From the READS Log, click the Generate Coversheet. 

Only the 1st page of a multi-page document needs a barcode.  All subsequent pages are included as part of a 
single document until one of the following 2 things happens.  1) the last page of the scanning job is reached.  In this 
case all scanned pages are included in a single document; or 2) another valid READS barcode is encountered. In 
this case a completely new document is started at the second barcode. This repeats until the last page of the job is 
reached. 

Multiple documents may be scanned at once as long as each document begins with a READS barcode. 

Be mindful of printing/scanning 1-sided documents vs. 2-sided documents.   
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Creating a Payment Request 
 
Before you create a payment request, check the “Payment Request Checklist” to make sure you haven’t skipped any 
approval steps in READS and to make sure all relevant supporting documents have been scanned into the Parcel Log 
(or Relocation Log or Project Log, as appropriate) in READS. The “Payment Request Checklist” can be accessed from 
the RE Forms and Docs list on the Real Estate home page.  
 

1. Go to your parcel in READS. Click Payment Request. 
 

2. Click “Create Payment Request” (upper right area of your screen). READS automatically fills in today’s date, 
the order number and your name. 
 

3. Choose the payment type from the drop‐down menu. READS fills in the class code and the invoice number. 
For Relocation and Additional Parcel Cost payment types a “List of Pending Costs” appears on the right side 
of the screen. 
 

4. If your payment request is a rush payment, click the “Rush Payment” box. 
 

5. Choose the payee(s) from the drop‐down menus in the “Payable To” field. If you need to add the name of a 
payee who is not a participant, click the “add new” symbol located next to the payee drop‐down menu, then 
type the payee name into that field. 
 

6. Type the dollar amount into the “Check Amount” field. For Relocation and Additional Parcel Costs payment 
types, choose the appropriate amount from the “List of Pending Costs.” (The pending costs should have been 
entered prior to creating the payment request.) 
 

7. In the “Check Handling” field choose an option from the drop‐down. This tells central office where to send 
the check. If you choose “other,” another list with more options will appear. 
 

8. If the check is to be mailed to a region office or consultant, nothing needs to be entered in the “Please 
Specify Mailing Address Below” field. All other addresses must be specified in this field. 
 

9. Use the “Comments” box to explain things such as: (a) why taxes aren’t prorated if your acquisition payment 
is >$10,000; (b) why a mortgagee or lien holder isn’t named on the check if your acquisition payment is 
>$10,000; (c) any other unusual circumstance(s) affecting payment. 
 

10. Click “Save” near the top of the screen. 
 

11. Click “Generate Payment Request.” Open the document and you can view it in Word to check it over for any 
mistakes. If you need to change something, close the document, click “Edit” in the payment request screen, 
make your changes, then save and generate again. 
 

12. At this point you’re ready to either submit your payment request to central office or forward your payment 
request to the appropriate approver by following the e‐authorization process. 
 

13. Once you’ve received notification that the approver has e‐authorized your payment request, you can then 
submit the payment request to central office. 
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Tips to Speedup Payment Request Turnaround Time 
 

1. If the plat page for your parcel is not accessible from READS, scan that page(s) into the Parcel Log. 
 

2. On the Participants screen, be sure mortgagee and lien holder information is current. 
 

3. Check the conveyance: Is the Grantor name(s) correct? Are other persons having an interest in the property 
correctly listed? Has the conveyance been signed and notarized? 
 

4. Check the Appraisal and Offer/Negotiations screens. Be sure all appraisals and offers have been approved. 
 

5. Check the Relocation Claims screens (if applicable). Be sure all claims have been approved appropriately. 
 

6. Check the Parcel Log. Be sure all supporting documentation is in the Log. This includes conveyances, 
purchase agreements, nominal‐waiver forms, partial releases of mortgage, admin revisions, disposition of 
R/E taxes, closing statements and invoices for owner appraisal fees and incidental payments. 
 

7. Check the Relocation Log (if applicable). Be sure all supporting documentation has been scanned into the 
Log. This includes the relocation claim form signed by the property owner, any pertinent receipts, approved 
RHP calculations, DSS inspections, business moving estimates, rent loss letters/agreements, and any other 
documentation affecting payment. 

8. Delete unnecessary duplicate copies of documents in your Parcel Logs, Relocation Logs, and Project Logs. 
 

Checking the Status of a Payment Request 

1. Go to your parcel in READS. Click Payment Request. 
 

2. Find the payment request and the box in the Status column. 
 

3. If the box says “submitted,” your payment request has been submitted to central office and will be 
processed as soon as possible. 

 
4. If the box says “audit,” that means central office has opened your payment request and is processing it. It 

remains in “audit” status until the check is cut and mailed. It will also remain in “audit” status if central office 
has requested, and is waiting for, additional documentation or information in order to continue processing 
your payment request. 
 

5. If that box below the Status column is blank, that means your payment request has not yet been submitted 
to central office. If you’re thinking it should have been submitted, retrace your steps: Is it still waiting to be e‐
authorized? If it’s already been e‐authorized, did you forget to submit it?   
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Ex6‐1 

Exercise 6 – Payment Request & E-Authorization 
 
Use the project ID and parcel numbers provided by the instructor 

1. Enter Training READS using your Training Logon and Password 

2. Navigate to Parcel 4 of your project in Parcel Central (Click Project > Project Details, Find your project 
and click the icon in the Edit column next to your project, click the Open Parcel icon for parcel 4) 

3. Click the Payment Request button.  It is at the very bottom of the Parcel Central Menu, you will have to 
scroll down to see it. 

4. Click the Create Payment Request button 

 
 

5. Select the Payment Type Acquisition.  Class Code 5550 fills in. 

 
 

6. Set Payable To the owner 
7. Enter the Check Amount 
8. Select a Check Handling option and Mailing address 
9. In the Comments section,  

 If there are Participants not named on the check, explain why. 
 If taxes will not be prorated, make a note. 
 If an award, note date of JO expiration. 

 
10. Click Save 

  
We have entered the payment information into the system. Now we will create the payment request document.   
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Ex6‐2 

1. Click Generate Payment Request 
 

 
 

2. READS generates the document, saves a copy in the Log and sends the document to MS Word.   
 

3. Word will prompt you to Open, Save or Cancel.  Click Open 
 

4. Examine the Payment Request.  Notice the checklist for this specific parcel type on page 2 
 

5. Close the Payment Request Document. 
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Ex6‐3 

E-Authorization 
 
Sometimes payment requests must be signed by a Supervisor prior to submittal.  This part of the exercise will 
walk you through the process of doing that electronically in READS. If supervisor approval is needed on a 
payment Request, you must do this prior to submitting the Payment Request to Central Office for processing.  
 
There are several documents that can be e-authorized in READs.To e-authorize a document, go to the log  
where the document exists. In this case, the parcel log for parcel 4. Documents that may be e-authorized will 
have a blue right-arrow symbol next to them in the e-Auth column. 
 
Request E-Authorization 
 
1. Click the e-Auth icon next to the Payment Request 
 

 
 
2. Set Forward To the Approver (in training set to Drew Kottke) 

 
3. Enter an Email Subject and an Email Msg 

 
4. Click Save 

 
The E-authorizer receives an email message and a Tickler in READS 
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Ex6‐4 

Perform E-Authorization 
 
Note: This will not be possible for you to perform at the training site. The instructor will demonstrate the process.  
 

1. Click My Ticklers to see notifications and documents waiting for your e-Authorization. 
 

 
 

2. Click the Open Link icon next to the document to e-authorize. 
 

3. READS opens the approval screen and the document itself. Click Open 
 

4. Examine the document. When done, close the document. 
 

5. On the approval screen, select Approved (or Rejected). 
 

6. Enter an Email Msg for the originator. (To quit without approving or rejecting, close the dialog by click the 
red X in the upper right corner.) 
 

  
 

7. Click Save 
 

8. READS will ask you to confirm that the document is closed and that you want to proceed. Click Yes. 
 

 
 

READS will apply your signature to the document and overwrites the unsigned copy in the log. READS sends 
an email notification back to the originator.  

 
9. READS opens the document for you to view again. Click Open. 

 
10. Verify that your signature was applied correctly and close the payment request document. 
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Ex6‐5 

Submit a Payment Request for Processing 
 
Back on the Payment Request screen, click Submit Payment Request to CO and click OK at the pop up. 

 

 
 

 
 
Payment Request Status 

 
Check the status of a Payment Request by going to the Payment Request screen and looking at the Status 
column. 
 

 
 
Usually the Payment Request Status will be Submitted, Audit or Check Issued. 
 
Once the Finance Unit begins the Audit process, the status is changed to Audit and the Payment Request 
may not be modified or deleted except by the Finance Unit. Once a Check is issued the status changes to 
Check Issued.  
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WisDOT Real Estate Delegation Table
 Updated 06/01/11

Note:  Delegation authorization is not extended to consultants or consultant project managers.

Activity

Region RE 
Specialist

RE Supv Hill Farms

Appraisal review/offering prices & new offering prices due to change in 
acquisition size/effect on remainder

         Nominal Payment Parcel Report (waiver of appraisals of ≤ $10,000 with 
no land severance or damages to improvements)

Designated 
Reviewer

X

         Short Format and Abbreviated Standard Appraisals ≤ $10,000 with no 
damages to improvements and land severance ≤ $5000

Designated 
Reviewer only

         Complex appraisals and offering prices that do not meet above criteria BTS Review 
Appraiser

Alternate Offers

         Where offering price + alternate offer does not exceed $10,000 Designated 
Reviewer only

         Where offering price + alternate offer exceeds $10,000 BTS Review 
Appraiser

Project Data Book (exception: region reviewer can approve where all 
appraisals were delegated to region reviewer

BTS Review 
Appraiser

Approval of owner appraisal payments (for reasonableness of fee and 
within time requirements)

X

Review of non-complex, surplus land appraisals ≤ $10,000 (except on land 
sales with federal funding)

Designated 
Reviewer only

Review of complex surplus land appraisals and those over $10,000 BTS Review 
Appraiser

Relocation Orders (original and revised) X

Early acquisition approvals (no federal $$’s allowed in acquisitions 
defined under process in REPM 3.2.2)

X

Advanced hardship and protective purchase requests BTS 
Acquisition 
Facilitator

Issuance of Jurisdictional Offer prior to 60 days BTS 
Acquisition 
Facilitator

Jurisdictional Offers and Award of Damages X

Administrative Revisions with additional monies of $250,000 or less X

Administrative Revisions with additional monies over $250,000

X

BTS Real 
Estate 

Manager 
concurrence

Additional parcel payments X

Purchase Agreement X

Litigation Legal settlements (state and local projects with federal or state $$ in R/W) X

Lowest Delegation Level     
(except where noted)
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Region RE 
Specialist

RE Supv Hill Farms

Acquisition Stage Relocation Plans BTS 
Relocation 
Facilitator

All farm, business relocations and mixed use computations and claims BTS 
Relocation 
Facilitator

Residential relocation computations (including consultant projects and 
LPA)

X

Residential relocation claims (=/< approved computation) Regional 
Relocation 

Specialist **

Residential relocation claims (> approved computation) X

Fencing claims X

Realignment of personal property – same site (moving expense findings not 
to exceed $2500)

X

Realignment of personal property – off site BTS 
Relocation 
Facilitator

Outdoor advertising sign relocations BTS 
Relocation 
Facilitator

QCD execution of surplus land sales < $3000 X

Sale of property valued at < $3000 (not including mutual benefit sales with 
values exceeding $3000)

X

Sale of property valued $3000 to $14,999 (not including mutual benefit sales 
with values of less than $15,000) DOT Secretary

Sale of property value ≥ $15,000 Governor

Signing of leases X

Consultant services contracts (for projects with federal or state $$ in R/W) LPA 
Coordinator

Acquisition Capabilities Statements

         Projects with federal or state $$ in R/W BTS 
Acquisition 
Facilitator

         Project without federal or state $$ in R/W LPA 
Coordinator

Nominal Payment Parcel Report (waiver of appraisals of ≤ $10,000 with no 
land severance or damages to improvements)

Designated 
Reviewer

X

Review of appraisals on projects with federal or state dollars in R/W

         Short Format and Abbreviated Standard Appraisals ≤ $10,000 with no 
damages to improvements and land severance ≤ $5000

Designated 
Reviewer

         Complex appraisals and offering prices that do not meet above criteria BTS Review 
Appraiser

Administrative Revisions (projects with federal or state $$ in R/W -- DOT 
approval needed to assure federal/state participation)

X

**  Delegation to regional Relocation Specialist at discretion of Real Estate Supervisor
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Relocation  Log 

Documents 

Business Comparison Chart (DT1958)                                                                              business only 

Business Moving Expenses ‐ Worksheet                                                                          business only 

Business Questionnaire (DT1970)                                                                                     business only 

Certificate of Legal Residency Form 

Determination of Supplemental Replacement of Business or Farm Payment 

(DT1609) 

business only 

Farm Comparison Chart (DT1972)                                                                                    business only 

Farm Questionnaire (DT1971)                                                                                           business only 

Individual Relocation Case Report 

Inspection and Certification of Decent, Safe, Sanitary Replacement Housing 

(DT1950) 

residential only 

Replacement Housing Payment Computation  ‐ Owner  (DT1943)   residential only 

Relocation  Assistance  Diary  (DT1957) 

Relocation Claim (DT1527) ‐ Claim tab 

Relocation Package Receipt 

Relocation Payment Estimate ‐ Business & Farm (DT1973)  business only 

 Relocation Payment Estimate ‐ Business & Farm (DT1679B)  business only 

Relocation Payments Summary ‐ Residential (DT1679R)  residential only 

Replacement Housing Payment Computation ‐ Tenant (DT1948)  residential only 

Residential Comparison Chart (DT1947)  residential only 

Residential Questionnaire ‐ Inventory of Individual Needs (DT1968)  residential only 

Residential Survey Questionnaire (DT1969)  residential only 

Restablishement Expenses ‐ Worksheet  business only 

Searching Expenses Record (DT1960)  business only 

Self Move Agreement (DT2266)  business only 

Vacancy Notice (DT1783) 
 
 

Letters 

48 Hour Notice Letter 

90 Day Occupancy (90 Day Notice of Occupancy) Letter 

Disconnection of Utility Services Letter 

DSS Replacement Inspection Letter  residential only 

Financial Commitment ‐ Owner Letter 

Initiation of Negotiations ‐ Business Owner Letter  business only 

Initiation of Negotiations ‐ Business Tenant Letter  business only 

Initiation of Negotiations ‐ Residential Owner Letter  residential only 

Initiation of Negotiations ‐ Residential Tenant Letter  residential only 

Moving Cost Estimate Letter 

Notice of Intent To Acquire Letter 

Occupancy and Summary Letter Rent 

Loss Letter & Agreement Letter 
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Adding Relocatees 
 
Example 1: One Parcel with Residential and Business Owner ‐ Participants Screen Setup 
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Example 1: One Parcel with Residential and Business Owner ‐ Relocation Screen Setup 
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Example 2: One Parcel with a Business Owner and Two Tenants ‐ Participants Screen Setup 
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Example 2: One Parcel with a Business Owner and Two Tenants ‐ Relocation Screen Setup 
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Example 3: One Owner (No relocation benefits) with Business Tenant, Sign Tenant and contacts 
Participants Screen Setup 
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Example 3: Contacts Setup 
 

 
 

 
 

Example 3: One Owner (No relocation benefits) with Business Tenant and Sign Tenant ‐ Relocation Screen Setup 
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Relocation Assignments 
 
Make sure the correct assignments are made on each parcel where there is relocation. 

 

 
 

Assignments may be made at the project level for many parcels at once.  
 
IMPORTANT: Do not simply assign an appraiser or a relocation specialist to all parcels on a project. You must 
specifically designate only the parcels where an appraisal or relocation is required. 
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WisDOT 01/31/13 

Wisconsin Department of Transportation 
Certification of Legal Residency in the United States 

 
 
In accordance with the federal Uniform Relocation Assistance and Real Property Acquisition Policies Act of 1970 and all 
subsequent amendments, persons seeking relocation payments or relocation advisory assistance shall certify that he/she 
and/or other members of the household are citizens, nationals or aliens who are lawfully present in the United States.  
This certificate shall remain in the Wisconsin Department of Transportation’s relocation file and serves as a basis for 
payment of relocation claims. 
 
Residential Displacements 
 
Individual:  I certify that I am a citizen of the United States. 
 (or) 
  I certify that I am an alien lawfully present in the United States 
 (or) 
Family:  I certify that there are       persons in my household that are citizens of the United 

States and       are aliens lawfully present in the United States. 
 
 

This signature constitutes certification. 
 
 
________________________________________________ ___________________ 
Signed by Head of Household Date 

 
 
 
Non-Residential Displacements 
 
Sole Proprietorship:  I certify that I am a citizen of the United States 
 (or) 
  I am an alien lawfully present in the United States 
 (or) 
  I am a non-U.S. citizen not present in the United States 
 
Partnership:  I certify that there are       partners in the partnership and       are citizens of the 

United States,       are aliens lawfully present in the United States, and       are non-
U.S. citizens not present in the United States. 

 
Corporations:  I certify that         is established pursuant 

to Wisconsin state laws and is authorized to conduct business in the U.S. 
  
 

This signature constitutes certification. 
 
 
________________________________________________ ___________________ 
Signed by Business Owner/Partner Date 

 
Note:  The Wisconsin Department of Transportation or its agents may request documentation or other credible evidence 
in addition to this certificate.  In addition, inquiries to the Immigration and Naturalization Services (INS) may take place. 
 

  

Project ID 
      

Unit No. 
      

Parcel No. 
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Relocation Assistance Package Receipt Wisconsin Department of Transportation 
Unnumbered     05/2012 

Name       Address       

This document is a receipt to confirm the WisDOT forms that have been delivered to you on this date. 

 
Relocation Payment - To be eligible for the following relocation payments, you must: 
 
Residential Housing Replacement Payment 
 Relocate your residence no later than one year after the later of:  (1) date you received payment from 

WisDOT; or, (2) date you moved from acquired property. 
 File a claim within two years from the later of:  (1) date you received payment from WisDOT; or, (2) date 

you moved from acquired property. 
 
Business Replacement Payment 
 Own or occupy a business/farm/non-profit conducted on the property acquired or affected by 

displacement for not less than one year before initiation of negotiations. 
 Relocated your business/farm/non-profit no later than two years after the later of:  (1) date you received 

payment from WisDOT; or, (2) date you moved from acquired property. 
 File a claim within two years from the later of:  (1) date you received payment from WisDOT; or, (2) date 

you moved from acquired property. 

Relocation Assistance Package (check all that apply) 

Wisconsin Relocation Rights (WI Dept of Administration 
brochure) 

 Residential  Business/Farm/Non-Profit 

WisDOT general relocation information notice  Residential  Business/Farm/Non-Profit 

Computation – residential housing replacement payment 
(includes form DT1947 and pictures) 

 Owner  Tenant 

Computation – business/farm/non-profit replacement 
payment (includes form DT1958 and pictures) 

 Owner  Tenant 

Relocation payment summary  Residential  Business/Farm/Non-Profit 

Relocation notice of eligibility letter  

Claim forms  

Certificate of residency  

Notice of vacancy  
 
The relocation agent has explained the advisory services and relocation payment that WisDOT offers to me 
as a relocatee; and, I have received from        on 
       the above (checked) items known as the “Relocation Assistance Package.” 
 
 

_______________________________________________________
 Signature Date 
 
Note:  This receipt indicates delivery and explanation of above items only; it does not necessarily indicate agreement. 
 
 
 
 
 

 

 

Project ID       County       Parcel No.       
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Ex7‐1 

Exercise 7 – Residential Relocatee (15 minutes) 

Use the project ID and parcel number provided by the instructor 

Make an existing residential owner participant a relocatee. Generate the 
Certificate of Residency, the Relocation Package Receipt and the Initiation the 
of Negotiations Letter 

1. Browse to your parcel in READS and go to the Acquisition Team screen 

2. If there is already an assignment for Relocation Specialist, skip ahead to number 4. Otherwise click 
Relocation Specialist 

 

3. Click “All Internal Staff and set the Relocation Specialist to Drew D Kottke and click Save 

 

4. Scroll down to Statewide Relocation Coordinator 

5. If there is already an assignment for Relocation Specialist, skip ahead to the next page. Otherwise click 
Statewide Relocation Coordinator 

6. Set the Statewide Relocation Coordinator to Kassandra Walbrun and click Save 
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Ex7‐2 

Now designate the property owner as a relocate. This creates a Relocation record in the system for this participant. 

1. Go to the Participants screen 

2. Edit the Owner record 
 

 

3. Click Edit 

4. Change Relocation to Yes. Enter a Unit # and set Relo Category to Residential 

5. Click Save 

 

6. Click Relocation on the left side of the screen 

7. Edit the Relocation record for your participant 

 

 

 

 

4
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Ex7‐3 

7. Click the Documents tab 

 

8. Click the Generate button next to the Certificate of Legal Residency 

9. When prompted by Word, click Open.  

At this point you could print the document and add it to the Relocation Package 

10. Close the document 

11. Now click the Generate button next to the Relocation Package Receipt 

 

12. When prompted by Word, click Open.  

At this point you could print the document and add it to the Relocation Package 

13. Close the document 

14. Now click the Letters button 
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Ex7‐4 

 

15. Click the Generate button next to the Initiation of Negotiations – Residential Owner Letter 

 

16. Make any desired changes in the dialog box and click Generate Letter 

 

17. When prompted by Word, click Open.  

At this point you could print the document and add it to the Relocation Package 

18. Close the document 
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Ex8‐1 

Exercise 8 – Residential Relocation Comparables (30 minutes) 

Use the project ID and parcel number provided by the instructor 

Enter data on subject property and 3 relocation comparables. Generate the 
Replacement Housing Payment Computation document. Generate the Relocation 
Payments Summary document. 

1. Browse to your parcel in READS 

2. Click Relocation on the left side of the screen 

3. Edit the Relocation record for your participant 

4. Click the Subject Prop tab.  

  
 

 
5. Click Edit 

 
6. Enter:  

a. Construction Type: Wood Frame 
b. Rooms: 8 
c. Bedrooms: 4 
d. Approx Habitable Area: 1505 
e. Habitable Area Required: 205 
f. Approx Age: 100 years 
g. State of Repair: Good 
h. Fair Housing: Yes 
i. Utilities Present: G, E, WE, SE 
j. Dist to Work: 12 mi 
k. Dist to School: 3 mi 
l. Dist to Shopping: 3 mi 
m. Dist to Transit: NA 
n. Dist to Other: NA 
o. Type of Neighborhood: Rural Residential 
p. Lot Size: 1.0 Acre 
q. Garage Size: 2 car 

 
7. Click Save 

a 

b 
c 
d 
e 
f 
g 

h 
i 

j 
k 
l 
m 
n 
o 
p 
q 

 

99



Ex8‐2 

 
8. Click the Project ID link to return to the project screen to enter Relocation Comparables 

 

 
 
 

9. On the Project Screen, click the Relo Comps tab 
 

 
 

10. Click Add Residential Comp 
 

11. Determine the Comparable Number to use. 
 
If your assigned parcel number is 4, enter 4-1 for the first comparable. If your assigned parcel number is 
13, enter 13-1 for the first comparable number. 
 

  
 

12. Enter the other data for comparable 1 as shown above. 
 

13. Click Save 

enter the parcel number followed by “-1”
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Ex8‐3 

14. Click Add Residential Comp again to enter the second comparable 
 

15. Determine the Comparable Number to use. 
 
If your assigned parcel number is 4, enter 4-2 for the second comparable. If your assigned parcel number 
is 13, enter 13-2 for the second comparable number. 
 

16. Enter the second comparable as shown below. 
 

  
 

17. Click Save 
 

18. Click Add Residential Comp again to enter the third comparable 
 

19. Determine the Comparable Number to use. 
 
If your assigned parcel number is 4, enter 4-3 for the third comparable. If your assigned parcel number is 
13, enter 13-3 for the third comparable number. 
  

 
 

20. Click Save 
 

21. Click Back to Parcel Central 
 

 
 
 

enter the parcel number followed by “-2”

enter the parcel number followed by “-3”
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Ex8‐4 

Perform the Replacement Housing Payment Computation 
 
1. Return to the Relocation screen for your parcel 

 
2. Click the Comparables tab 

 

 
 
You will see your comparables and you may see additional comparables for other parcels on the project. 
 

3. Designate the “-2” property as the most comparable. Click the View/Edit button  next to it. The 
comparable dialog opens. 
 

 
 

4. Enter the necessary information here and set Most Comparable to Yes. 
 

5. Click Save 
 

6. On the Comparables tab, place a checkbox next to the 3 comparables to include on the Residential 
Comparison Chart. 
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Ex8‐5 

7. Click the Computations tab 
 

8. Select Replacement Housing Payment Computation – Owner from the pull down menu 
 

9. Click Edit 
 

  
 

10. Enter the name of the Computation approver and the date approved. 
 
Note that the Carve Out checkbox will allow you to modify the Acquisition Price of the Subject Dwelling 
 

11. Click Save 
 
 

Generate the Replacement Housing Payment Computation document 
 

1. Click the Documents tab 
 

 
 

2. Scroll down to the Replacement Housing payment Computation – Owner document and click the Generate 
button 
 

3. Click Open to open the generated file in Word 
 

 
 

4. After examining the Replacement Housing Computation document, close Word. 
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Ex8‐6 

Generate the Residential Comparison Chart  
 

1. Click the generate button next to the Residential Comparison Chart 
 

  
 

2. Click Open to open the generated file in Word 
 

3. After examining the Replacement Housing Computation document, close Word. 
 
 
Generate the Relocation Payments Summary  

 
1. Click the Pymt Summary tab and click Edit 

 

 
 

2. Select Payment Summary Type: Original 
 

3. Check the first box under Replacement Housing Payment for Owner Occupants 
 

4. Scroll down and select Fixed schedule under Moving Expenses – Residential 
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Ex8‐7 

5. Fill in the number of rooms and schedule dollar amount using the Fixed Payment Schedule in the Real 
Estate Program Manual. 
 

6. Click Save 
 

7. Click the Documents tab 
 

8. Click the generate button next to the Relocation Payments Summary 

 

9. Click Open to open the generated file in Word 
 

10. After examining the Replacement Housing Computation document, close Word. 
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Relocation Assistance Diary 
 
The provisions regarding what items must be maintained in the region’s official files are found in the Wisconsin 
relocation rules in Wis. Admin. ch, Adm 92. (Wi Stats 32 and 84 are silent with regard to a negotiation diary 
requirement). The following language is found in Adm 92.20. 
 
Adm 92.20  Relocation file. An agency shall maintain a current individual property acquisition and individual 
relocation case file. The file shall be retained for inspection by the department for a minimum of 3 years following 
completion of a project or a final relocation payment, whichever is later.  

 (2) INDIVIDUAL RELOCATION CASE FILE. An agency shall develop and maintain an individual case file for a 
displaced person beginning with information obtained in the initial interview. An individual relocation case file 
shall include the following:  

 (a) Name, on-site address and phone number, date of displacement, replacement address and phone number, and if 
a tenant or an owner, before and after relocation;  

 (b) The age and sex of dependent household members, the average monthly income of adult household members 
and the monthly housing cost of an acquired and replacement dwelling;  

 (c) A description of the business or farm operation being conducted, whether a displaced person relocated or 
discontinued, and the average monthly cost of the acquired and replacement facilities;  

 (d) A description of a dwelling, habitable space, number of rooms and bedrooms, and the type of construction;  

 (e) A description of relocation needs and preferences;  

 (f) Evidence that a displaced person received a pamphlet entitled, "Wisconsin Relocation Rights," and the date 
received;  

 (g) A copy of a written notice as specified under this chapter or otherwise given to a displaced person;  

 (h) Relocation service and assistance provided and the date;  

 (i) Referral to a replacement dwelling, business or farm operation, including the date, address, and sale or rental 
price;  

 (j) A copy of an occupancy agreement for the period after acquisition;  

 (k) A copy of a replacement property inspection document with the inspection date, description of a property and 
its condition;  

 (L) Type and amount of each relocation payment made;  

 (m) A copy of a relocation claim and supporting documentation and related documents for determining eligibility 
for or an amount of a payment, evidence of payment, and correspondence relating to a claim;  

 (n) A copy of an appeal and an explanation of the action taken to resolve the appeal, and the final determination;  

 (o) A copy of individual relocation case reports or other correspondence with the department;  

 (p) The agency representative who provided relocation assistance.  

 (3) RECORDS AVAILABLE FOR INSPECTION. Property acquisition and relocation records shall be available for 
inspection by the department, and any person as specified under the Wisconsin Open Records Law, ss. 19.31 to 
19.39, Stats.  
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Ex9‐1 

Exercise 9 – Relocation Claims (15 minutes) 
 
Use the project ID and parcel number provided by the instructor 

Create blank Relocation Claim forms to provide to a specific relocatee 

1. Browse to your relocatee record in READS and click Edit 
 

 
 

2. Click Claims Tab 
3. Click Add New 

 

 
 

4. Click Edit and then Click Save 
 

   

5. Click Back 
6. Click Generate Relocation Claim. 

 

 

The claim form generates and is saved in the log for this relocatee.  Word opens the form. 
   

7. Print and provide as many as desired for this specific relocatee’s use. 
 

IMPORTANT: Because the barcode on the form is linked to this specific relocatee, do not use this form for any 

other relocatee.   
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Ex9‐3 

Enter the Relocation Claim in READS 
 
Prior to generating a Relocation Payment Request, check the Relocation Log to verify all supporting 
documentation has been attached. Include the relocation claim form signed by the property owner, any 
pertinent receipts, approved RHP calculations, DSS inspections, business moving estimates, rent loss 
letters/agreements, and any other documentation affecting payment. Delete unnecessary duplicate copies of 
documents in your Parcel Logs, Relocation Logs, and Project Logs.  
 

1. Browse to your relocatee in READS and click the Claims tab 
 

2. Since there is an unused sequence 1 claim ($0.00 approved from creating barcoded forms) click Edit 
 

    
 

3. Click Add New Type 
 

 
 

4. Enter the Claim Type, Amount Claimed and Amount Approved. Click Save 
 

 
 
Multiple Types can be entered on a single claim. 
 

5. Click Edit 
 

6. Set Approved by to Norman Pawelczyk and Approved on to today 

 

   
 

7. Click Save 
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Ex9‐4 

Create the Relocation Claim Payment Request 

1. Click the Payment Request button at the bottom of the Parcel Central Menu 

2. Click the Create Payment Request button 

 
 

3. Select the Payment Type Relocation Claims.  Class Code 5550 fills in. 
 

 
 

4. Set Payable To the owner 
 

5. Click the Include checkbox in the Lists of Pending Costs Table. The check amount fills in 
 

6. Set Check Handling to Region Office 
 

7. Click Save 
  

We have entered the payment information into the system. Now we will create the payment request document.   
 

1. Click Generate Payment Request 
 
READS generates the document, saves a copy in the Log and sends the document to MS Word.   
 

2. Word will prompt you to Open, Save or Cancel.  Click Open 
 

3. Examine the Payment Request.  Notice the checklist for this specific parcel type on page 2 
 

4. Close the Payment Request Document. 
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INDIVIDUAL RELOCATION CASE REPORT ID NO This Case 
(from relocation plan) 

 Parcel No 
     Unit No

11___ 
__

 
 Please submit this report within 30 days 

after displacement and payment of 
relocation claims for each displaced 
person. 

 
 

Relocation Unit, State Energy Office, Department of 
Administration, PO Box 7868, Madison, WI  53703

Federal Relocation     Yes 
Law Applies                 No 
_______________________ 
Date Person Moved In (on site) 
04/30/2003 

Date Replacement Inspected 
11/07/2012 
_______________________ 
Date Negotiations Began 
10/30/2012 

Date Prepared Prepared By Phone Date Person Moved Out Date Property Acquired 
02/27/2013 Sarah Simpson (The Highland Group) (920) 262-2150 12/18/2012 12/14/2012 

Acquiring Agency 
Green Bay  office (Northeast) 

Project Name 
STH 76 - New London 

 
  This unit was shown as occupied in the relocation plan but was vacant  

         prior to initiation of negotiation to acquire. 
Name of Displaced Person 
Mark W Nickel and Kristen Nickel 

Phone 
(950) 858-3341 

 
  This unit was vacant at the time of plan approval but was occupied prior 

         to acquisition.
Address (acquired)                         City                                              State                                           Zip 
W9917 Kelly Dr. ,Hortonville, WI 54944  

 
 
Person Moved to: 

 
 

Address  (replacement)                  City                                               State                                          Zip 
 W7226 Moonlight Dr., Greenville,  WI  54944  

 
        Residential 
 

  D.S.S. Housing 

 
        Non-Residential 
 

  Adequate Replacement 
Displaced Person Is: 

  Residential Owner                                Business Owner                                    Non-Profit  
  Residential Tenant                               Business Tenant                                    Farm Owner 
  Mobile Home Occupant                        Non-Profit Owner                                  Farm Tenant 

  Comparable Housing  
  Non-D.S.S. Housing 
  Publicly Assisted Housing 

  Comparable Replacement  
  Non-Code Compliant Repl. 
  Discontinued Operation 

RESIDENTIAL BUSINESS, FARM or NON-PROFIT 
  Family                    Individual Family Size     __2__/__4__ 

                      (adults/children) 
Name of Business/Farm/Non-Profit 
 

No. of Employees  
0 

Head of Household is: 
 

  Female                        White 
 

  Male                            Non-White 
 

  Elderly (over 65) 

Gross  
Income/Yr.     $83,000 

Type of Operation 
 

Annual Net Income  
$ 

Source(s) of Income 
 

  Wages/Salary              Pension 
  Social Security            Interest 
  Public Assistance        Other 

Type of Interest Acquired 
 

  LAND and BUSINESS             OTHER (specify) ______________________ 
  BUSINESS ONLY                          
  LEASEHOLD IMPROV.         

  
ACQUIRED 
UNIT 

 
SELECTED 

COMPARABLE 

 
ACTUAL 

REPLACEMENT 

  
ACQUIRED 

UNIT 

 
SELECTED 

COMPARABLE 

 
ACTUAL 

REPLACEMENT 
TYPE UNIT (single 
fam., duplex,  
multi-fam., etc.) 

Single Family Single Family 
 

Single Family  TYPE OF BLDG.  
(office, free standing, mixed 
use, etc.) 

   

NUMBER OF 
ROOMS/ 
BEDROOMS 

 
11/5 

 
11/5 

 
6/4 

LAND AREA    

OVERALL SIZE 
(square footage) 

2,170  sq. ft. 
 

3,081 sq. ft. 
 
 

1,221 sq. ft. 
 

BUILDING   
(square footage) 

   

ACQUISITION 
PRICE 

 
$230,888.17 

 
$289,900 

 
$294,900 

ACQUISITION PRICE $ $ $ 

MONTHLY RENT 
(with utilities) 

 
$NA 

 
$NA  

 
$NA  

MONTHLY RENT 
(with utilities) 

$ $ $ 

CHECK IF CARVE 
OUT WAS DONE  

 
 

 
 

 
 

CHECK IF CARVE OUT 
WAS DONE ON 

 
 

 
 

 
 

RELOCATION PAYMENTS 
Type of Payment (ie.  move, rent 
differential, searching, etc.) 

DATE AMOUNT NOTE:  If a person has not 
filed or received payments, or 
was paid more or less than the 
person appears eligible for 
according to the data in this 
report, state the reasons on the 
reverse side. 
 
 
If carve-out was necessary in 
determining the replacement 
payment amount, explain 
method and computations used 
on reverse side. 

CLAIM PAID CLAIMED PAID 

Replacement Housing: Owner-
Occupant 

11/27/2012 12/14/2012 $89,900.00 $89,900.00 

Closing Costs & Related Expenses 11/27/2012 12/14/2012 $1,660.50 $1,660.50 

Moving Expenses: Optional Fixed 11/27/2012 12/18/2012 $4,900.00 $4,900.00 

   $ $ 

   $ $ 

   $ $ 

   $ $ 

   $ $  
Is this the final case report for 
this project? 
            YES 
             NO 

   $ $ 

   $ $ 

                                                                            Total $96,460.50 $96,460.50 

 
 Rev. March 2012 
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On October 30, 2012, WisDOT initiated negotiations and provided the displacees with their relocation 
assistance package for the above referenced parcel. It was determined at this time that the property owner’s 
were in a negative equity situation. 

 
The owner’s originally purchased the acquired property on April 30, 2003 for $155,000. In 2007 the 
homeowners took out a second mortgage on their home. For this loan, an appraisal was prepared dated August 
8, 2007 by Easy Mortgage, LLC with an appraised value of $277,000. For the WisDOT acquisition, Active 
Appraisal Services completed an appraisal on August 27, 2012 with an estimated value of $200,000. It was 
decided that the closing for this property would be on December 14, 2012. Due to the negative equity 
situation, the offer was increased to the payoff amount of $230,888.17. 
 
Documentation for the Negative Equity Waiver was sent to the Bureau of Technical Services Real Estate/ 
Relocation Facilitator on November 21, 2012 for approval. The Negative Equity Waiver was approved on 
November 27, 2012, therefore allowing the owner’s Replacement Housing Payment to remain at the original 
offer of $200,000. 
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Ex10‐1 

Exercise 10 – Individual Relocation Case Report (20 minutes) 
 
Use the project ID and parcel number provided by the instructor 
 

Enter data on the replacement property. Generate the Individual Relocation 
case Report. Protect and unprotect Word documents. Reattach documents to 
the log. Notify the Central Office relocation Facilitator regarding the Case 
Report 

1. Browse to your parcel in READS and go to the Relocation screen 

2. Edit the Residential owner record 

 

3. Click the Replacement tab 
 

 

4. Click Edit 

5. Enter actual replacement property information, including the DSS Inspection date 

6. Click Save 
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Ex10‐2 

Generate the Individual Relocation Case Report 

1. Make certain that all appropriate relocation dates have been entered 

2. Click the Documents tab 

3. Click on the Individual Relocation Case Report Generate button. 

 

The Individual Relocation case report takes a minute to generate. Wait until the green “Processing…” 
message disappears and the File Download dialog appears. 

4. Click Open 
 

 

IMPORTANT: In order to fill in the gray fill-able fields in Microsoft Word, such as the checkboxes below, the Word 
document must be protected. To edit any other part of the document, such as the addresses below, the document 
must be unprotected. Consequently it is necessary to know how to protect and unprotect Word documents. 
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Ex10‐3 

To Protect and Unprotect Word 2007 Documents 

First turn on the Developer tab in Word. This only needs to be done once. The Deveoper tab will stay on. 

1. If the Developer Tab appears on the ribbon, skip to the next page 

 

2. If the Developer tab does not appear, click the round Office Button in the upper left corner 

3. Click the Word Options button 

 

4. On the Word Options dialog (Popular tab) click Show Developer tab in Ribbon and click OK.  

 

The Word Deveoper tab will now stay visible on this computer. 
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Ex10‐4 

To protect an unprotected Word document  

1. C lick Developer > Protect Document > Restrict Formatting and Editing  

 

2. Check “Allow only this type of editing in the document:” and set the pull down menu to Filling in forms. 

 

3. Click Yes, Start Enforcing Protection 

4. Leave the password fields blank and click OK. 

   

To unprotect a protected Word document (not secured with a password) 

1. C lick Developer > Protect Document > Restrict Formatting and Editing  

2. Click the Stop Protection button in the lower right.   
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Ex10‐5 

To complete the Individual Relocation Case Report you must do some editing in Word.  

Documents modified in Word are not automatically saved back to the READS log.  To save a 

modified document to the log, first save a copy on your desktop and then use the “paper clip” 

upload button in the log to put the document back in READS.  

1. Make necessary changes to the document in Word. 

2. Click the round Office button and click Save As 

3. In the Save As dialog box, click Desktop on the left side  

4. Make a mental note of the file name (in this case, Doc154768[1].rtf)  

5. Check that the Save as type is set to Rich Text Format (*.rtf) and click Save. 

Save as type must be set to Rich Text Format or the document will be unreadable in 

READS.  

   

 

Now put the modified Individual Relocation Case Report back in the READS log 
 

1. Click the Relocation Log tab  
 

 
 
Notice that the Case Report is the most recent document in the log 
 
 

3 

4 
5 
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Ex10‐6 

2. Click the paper clip Upload button for the Individual Relocation Case Report. 
 

 
 
The Document Info screen appears 
 

 
 
Notice that the Document Type and the Prepared Date refer specifically to the Individual Relocation Case 
Report that you generated a few minutes ago.  

 
3. Click the Browse button and the Choose File to Upload dialog appears 
 

  
 

4. Click Desktop on the left side  
 

5. Double-click the modified Individual Relocation Case File that you saved there a moment ago. 
You will be returned to the Document Info screen   
 

6. Click Save 
 

READS will upload the modified version of the Individual Relocation Case Report and overwrite the original.  

4 

5 
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Ex10‐7 

Notify the Statewide Relocation Coordinator that the Individual Relocation Case Report has been completed 
 
1. Click Edit 

 

 
 

2. Double click in the Case Report Prepared field to enter today’s date and click Save 
 

3. Click the Notify CO Re Case Rpt button on the Relocation screen 
 

 
 

4. In the email dialog box, click Address Book 
 

 
 
5. In the Address Book, click Acquisition Team and then click Kassandra Walbrun (below left) 

 

            
 

6. Click Cc and then click Drew Kottke (above right).  
 
In practice you could use the Cc function to send yourself a copy of the message for your records. 
 

7. Click Close  
 

8. Add additional comments in the body of the email message if desired and click Send 
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BUSINESS MOVING EXPENSES – WORKSHEET Wisconsin Department of Transportation 
Unnumbered     05/2012 
 
Business name 
      

Present address 
      

Replacement address 
      

-- Complete all applicable areas -- 

1. Transportation of personal property (includes packing, crating, unpacking and uncrating).  
[Adm. 92.56(b)] $       

2. Dismantling, disconnecting, reassembly and reinstallation of personal property.  [Adm. 
92.52(c)] $       

3. Utility and service line reconnection (including telephone).  [Adm. 92.52(c)] $       

4. Utilities from R/W to replacement site.  [49 CFR Part 24.303(a)] $       

5. Searching expenses ($2,500 max).  [49 CRF Part 24.301(g)(17)] $       

6. Physical changes necessary at replacement property to accommodate personalty.  [Adm. 
92.52(c)] $       

7. Storage for 	 	 	 	 	  months (requires preapproval).  [Adm. 92.52(d)] $       

8. Replacement value insurance for move.  [Adm. 92.52(f)] $       

9. Licenses, permits and certification fees for business operation.  [Adm. 92.52(h)] $       

10. Professional services (requires preapproval).  [49 CFR Part 24.303(b)] $       

11. Stationery; re-lettering; and, reprinting (based on existing stock).  [Adm. 92.52(k)] $       

12. Sign re-lettering.  [Adm. 92.52(k)] $       

13. Loss of tangible personal property/substitute property.  [Adm. 92.56(2)] $       

14. Reasonable cost to sell personal property not relocated.  [49 CFR Part 24.301 (15)] $       

15. Self-move – lower of two bids (attached).  Requires self-move agreement (attached).  
[Adm. 92.56(1)(b)] $       

16. Low value / high bulk property.  [Adm. 92.56(1)(c)] $       

17. One time impact fees.  [49 CFR Part 24.303(c)] $       

18. Other items considered necessary.  [Adm. 92.52(o)] $       

Total $       

Note: Supporting documentation (receipted invoices, etc.) must accompany claim. 

 Project ID 
      

Highway 
      

Parcel No. 
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Reporting in READS 
From the main menu, click Reports 

Select Standard  

From the pull down list, select the desired report 

 

The report detail appears and the Filters tab opens by default 

 

Filters must be specified prior to running reports to achieve the desired result. 
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To run a report on a single project, add the filter “Project ID” and specify “Exact Match” and then enter the Project ID 

with dashes. 

 

To add a date range, add the filter “Closing Date” and specify “Between” and then enter the desired date range. 

 

Remember that in READS you must always enter a 4 digit year.  You may either enter 4 digits for month and day or 

enter slashes.  For example Jan 9, 2011 may be entered either as 01092011 or 1/9/2011. 

Once the filters are set as desired, click Run Report in the upper right part of the screen. 
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READS opens the report in a new Window.  Note that reports may span many pages. 

 

When done, close the Detail Report window using the X in the upper right corner 

 

 

Exporting to Excel 

To Export to Excel use the Create Log button. Use of the Convert To Excel button is not recommended when there 

are Project IDs in the report.  Project IDs may be converted to dates and the vertical alignment of cells makes reading 

the report difficult without modification. 

1. Click Create Log 

 

READS opens another window and then asks if you want to Open, Save or Cancel.   

 

2. Click Open 

 

Excel opens the report. 

 

3. To return to READS, in addition to closing the Detail Report window, close the blank browser window using 

the red X in the upper right corner. 
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Hints for Formatting Reports in Excel 

Column Width 

To change the width of columns, click to the right of the column letter and drag to the desired width.  Double‐click to 

automatically size to fit the widest entry in the column. Rows may be sized similarly. 

     

You may also right‐click on a column letter and select Column Width from the pop‐up. Enter the  column width 

desired.  The number is very roughly the number of characters that will fit in the cell. 

Cell Formatting 

With cells selected, you can change the font, text size, text color, orientation, etc. from the Home tab on the ribbon. 

 

Formatting in Excel applies only to selected cells.  To select all cells in a spreadsheet, click in the upper left area of the 

spreadsheet. 

 

To select multiple columns, click on the left most column letter, hold the mouse button down and drag to the right‐

most column letter.  Release the mouse button.  The columns will be selected. Multiple rows may be selected in a 

similar manner. 

 

126



       

You may also select cells then right‐click on the cells and select Format Cells from the pop‐up menu. 

 

Some Common Formatting Options 

Format Currency 

 

 

Add or Change Borders 

 

 

 

Wrap Text 

   

 

127



       

My Reports 

READS allows users to copy and modify reports and save them as “My Reports.”  Unless granted an exception by 

management, users are limited to 10 My Reports. 

It is possible to create a report from scratch but the easiest method is to copy an existing report. 

Click Reports then click Copy Report 

 

The Copy Reports window appears.  Here you specify where to copy the report from and where to save the new 

report.  You may copy from your own My Reports, the Standard Reports or another users My Reports. Give the new 

report a meaningful name and click Send Report. 

 

Once the report is in you’re my Reports you may modify the report if needed and resave it.   
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Ex11‐1 

Exercise 11 – Reports (10 minutes) 

Running the READS Relocation Claims Detail Report 

1. Click Reports > Standard > RELO – Relocation Claims Detail 

 
 

2. On the Filter tab, in the Project ID field enter your assigned Project ID 

 
      

3. Click Run Report  

   
 

4. Close the READS report window 

 

129



Ex11‐2 

5. Click Reports > Standard > RELO – Relocation Claims Detail 

 

6. Remove the Project ID Filter by clicking on the X button by the Project ID filter 

 

 
 

7. Add a specific Relocation Specialist 

 

8. Click the down arrow under Corresponding Secondary Views and select Roles (below left) 

 

              
 

9. Place a checkbox next to Relocation Agent (above right) 

 

10. Set the Relocation Agent Filter Type to “Select One or More” 

  

11. Click the Edit button next to the Filter Value and select yourself from the list and click Save 

12. Click Run Report 

13. After reviewing the report, Close the READS report window 
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Ex11‐3 

Save a copy of the report in My Reports 

 

1. Click the Save tab 

   

2. Add a description if you wish and click Save as My Report 

3. Click OK on the popup 

 

4. Now click My Reports. 

You will see the new report in the list 

   

  Once the report is in you’re My Reports you may copy it, modify it, rename it, etc.   
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READS TRAINING EVALUATION Wisconsin Department of Transportation 

Your input will help us in our continuing effort to improve the effectiveness of our READS training courses. Thank you for taking 
the time to complete this form.  Return this completed form to: Drew Kottke; WisDOT; 4802 Sheboygan Ave – Room 501 
Madison, WI  53705.   

Course Title 

 

Date of Training

 

Instructor Names(s) 

 

Your Name (Optional)

 

1.  Overall, how would you rate this course?  Check one number (10 = High; 1 = Low) 

  10    9    8    7  6 5 4   3  2 1

2.  The instructor covered the course objectives. 

  Strongly 

  Agree 

  Agree    Slightly

  Agree 

Slightly

  Disagree 

Disagree  Strongly

  Agree 

3.  The instructor used effective presentation skills.  

  Strongly 

  Agree 

  Agree    Slightly

  Agree 

Slightly

  Disagree 

Disagree  Strongly

  Agree 

4.  To improve this training, what would you: 

  Expand:   

 

  Add:   

 

  Delete:   

 

 

5.  Give other general comments about the course instructor or content.   

 

 

 

 

 



 



WISCONSIN DEPARTMENT OF TRANSPORTATION  

READS Electronic Signature Request 
 
For individuals that would like READS to place a facsimile of their 
signature on documents generated from READS (when appropriate). 
 
1. Print this page on white paper 
 
2. Enter your name and email address 
 

________________________________________ 
 
________________________________________ 
 
 

3. Using black ink, sign inside the box  
 

 
 
 
 
 
 
 
 

            

4. Scan to PDF and email to me at: drew.kottke@dot.wi.gov   
 
We’ll add your electronic signature to READS. Please call or email 
with questions.   
 
–Drew   608 267‐9074 
 


	table of contents
	general info
	reads email list

	wams id
	requesting access
	reads launch page

	pc settings
	reads highlights

	system controls

	main menu overview
	basic navigation

	assignments

	exercise 1 - project and plat
	exercise 2 - parcels, participants, interests

	negotiation diary
	legal descriptions

	exercise 3 - nominal valuation
	entering remnants

	exercise 4 - appraisal and offer
	electronic records law
	save as pdf
	reads logs

	word document protection
	documents and letters


	exercise 5 - reads log
	creating a payment request
	exercise 6 - payment request & e-authorization
	real estate delegation table

	relocation
	adding relocatees

	assignments

	certificate of legal residency
	relocation package receipt
	exercise 7 - residential owner

	exercise 8 - comparables
 
	relocation diary
	exercise 9 - relocation claims

	individual reloaction case report
	exercise 10 - case report
	business moving expenses worksheet

	reporting

	exercise 11 - reports


	Elec Signature Request



